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What is Artisteer?

Artisteer is the first and only Web design automation product that instantly creates fantastic looking Website
and Blog templates. It is powerful software that makes YOU a professional Web designer of Websites,
WordPress themes and blog templates. It lets you create fantastic looking Website designs and templates

in just minutes, without having to know anything about editing graphics or HTML.

With Artisteer YOU immediately become a Web design expert, editing and slicing graphics, coding XHTML
and CSS, and creating CMS templates and WordPress themes - all in minutes, without Photoshop or

Dreamweaver, and no technical skills.

Use Artisteer to generate cool Web design ideas, adjust the generated designs using many included
elements, backgrounds, photo objects and buttons, create professional, tableless, cross browser
compatible and fully compliant HTML and CSS code and export your design to create great looking Web

and Blog templates.

Creating great designs has never been easier!
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How to work with the Artisteer interface?

The Artisteer interface is quite simple to learn. There are several main items: Main Menu, Quick Access

Menu, Tabbed Navigation Bar and Design Preview (highlighted on the image below).

Main Menu contains basic file commands, recent documents and other standard items for File menu.
Quick Access Menu contains Undo, Redo, Save and Open shortcuts.

Ribbon contains all available editing tools.

Design Preview lets you see how your design will look like. Clicking on any objects in the Design Preview

will automatically change the tab on the Ribbon bar to the options you can use to style those objects.

( Main menu \’ [ Quick Access Toolbar ] l Ribbon J [ Design Preview ]
@ Fter 17 i ©undo txocon (RWordPress Theme = - Artisteer 3 Standard Edition
Ideas Colors & Fonts  Layout Background Sheet Header Menu Articles Seddbar Vertical Menu Buttons Footer <«
\‘\ ﬁ Suggest Colors ] Suggest Background Wl Suggest Header | / { 3
’ A Suggest Fonts || Suggest Sheet " suggest Menu L
SUDPERLENON -.'é] Suggest Layout l_i Suggest Sidebar If_) Suggest Article Design s‘y.‘“ wr::?:;e.s <
ideas Element [deas Expont

2 CEGHGE

Siogan text

M Menu ltem About

Venlfal Menu Text, Link, Visited, Hovered

Wednesday, November 05, 2008 | Author Admun | Edit

Lorem %
consects
link, how

adipiscaing elit. Quisi
felis. Mauns sempet
quam diam dictum
more link in quam. E
eget, rhoncus at, co

. Aliquam pharetra. N
blandit Maecenas at
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The Quick Access Toolbar is a customizable toolbar that provides the ability to create one-click shortcuts to

frequently used commands and quickly perform the most common tasks.

By default, the Artisteer Quick Access Toolbar contains the Open, Save, Undo, Redo and Export

commands, but you can customize the content of the toolbar by adding or removing items as you like.

To add a new item, right click on the desired command button in the Ribbon bar and select "Add to Quick

Access Toolbar" option.

To remove an existing item, right click on the item in the Quick Access Toolbar, and select "Remove from
Quick Access Toolbar".

Note: Not all the commands located in the Ribbon bar can be added to the Quick Access Toolbar. For
some commands, the "Add to Quick Access Toolbar" option in the right click menu is disabled.
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You can download the Artisteer installation file from the official Artisteer Web site at
http://www.artisteer.com. The software is provided with a free trial period that allows you to evaluate the
product before purchasing. During this period of time, Artisteer is fully functional and has all its features
available for testing, however you will not be able to save your Artisteer project. Also, you can export
templates, but all the templates and images generated with Artisteer will have watermarks on them until the
product is activated. The trial period is unlimited so you can activate the software at any time you wish and

the activation instructions are provided in the Activating the Software chapter.
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There is only one platform version (Mac or PC) of the Artisteer software that you install on your system, but
the features available in Artisteer depend on the type of license you have purchased. If you purchased the
Standard edition, all features of Artisteer are available. If you purchased the Home edition, there are certain
templates you will not be able to export and you will not be able to set most of the custom options available

in the Standard edition. The following chart illustrates the differences between both editions:

Version Home&Academic Edition Standard Edition

Free upgrades for 1 year v v
Design Suggestions v v
Design Features v v
Export as XHTML+CSS v v
Export as Wordpress Theme v v
Export as Blogger Template v v
Export as Joomla 1.5 or 1.6 v
Template

Export as Drupal 5/6/7 Theme v
Export as ASP.NET v
Application

Export to CodeCharge Studio v
Custom Values Dialogs* v
Library of Textures, Glares, v

. partial (75%)
and Gradients

Number of Color and Font
50+ 70+
Schemes
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*Custom Values Dialogs refers to additional customization options available in the Standard edition.
Normally, these appear with the ™ icon in the bottom right corner of the command block on the
Ribbon bar. Also, many submenus in Artisteer have a More... selection or a specific item selection

that allows you select advanced options (e.g. Font Options..., Gradient Options..., etc.)

B Fill Color -
Ml Gradient~
Background

You can find more information about these options in the Further Customization section
below.
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This section describes the system requirements for the Artisteer software.

Windows

e Intel® or AMD® processor 1500 Mhz or faster

e 150 MB free disk space

e 1GBof RAM

e Microsoft® Windows® XP, Windows Vista® or Windows Seven®

e Microsoft .NET Framework 2.0+. It can be obtained from the Microsoft website at:

Mac OS (Intel)

e Intel Core™ Duo 1.33GHz or faster processor
e 150 MB free disk space

e 1GB of RAM

e Mac OS X v10.5.x or 10.6.x

Mac OS (PowerPC)

e Not supported

Browsers supported

e Internet Explorer 7+
o Firefox 2+

e Opera9+

e Safari 1+

e Google Chrome 1+

Technologies supported

artisteer.com | page 11
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e CodeCharge Studio 4

e WordPress 2.7-3.1 content management system
e Joomla (1.5, 1.6) content management system

e Drupal (5.x, 6., 7.X) content management system
e Blogger

e DotNetNuke 4.9+

e ASP.NET / Visual Studio

e Artisteer.net

Standards supported:

e XHTML 1.0 Transitional
e (CSS2

e Section508 (partially)

e PNG with transparency
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This chapter describes how to install Artisteer on your computer.

Before you proceed, please make sure that your computer meets the requirements listed in the System

Requirements chapter.

Log into Windows as a Power User, or assume the Primary Administrator role.

Double-click the installation file called ArtisteerInstall.exe. This will launch a standard installation process.

Select the language that you’d like to use during the installation. Click the Next button.

Follow the instructions provided by the installation wizard.

Carefully read the License Agreement. If you accept its terms, check "I Accept the terms of the License

Agreement” option and proceed to the next step. Otherwise, quit the installation.

Select the destination folder where you want to install the product.

Indicate whether you want to create shortcut icons on the desktop and Quick Launch panel.

Click Install button to start the installation.

Click Finish button when the installation is complete.
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After you have purchased Artisteer you will receive a License Key to be used to activate the software. The
type of license that you purchase determines the features that are available in Artisteer (‘Home’ vs.
‘Standard’). The activation removes the watermarks added to the generated templates by the trial version.
It also automatically enables all of the features of Artisteer for the edition you have purchased (‘Home’ vs.
‘Standard’).

To activate the product select File - Artisteer Activation and enter your license key number in the first box.
If your computer is connected to the internet, check "Auto-activation through the internet" option and click
the Activate button. If successful, the software will connect to the Artisteer servers on the Internet, return an

activation key, and automatically enable the features of Artisteer.

If you work off-line, use the following link to obtain the activation key from any other computer connected to
the web:

In this case uncheck the "Auto-activation through the internet” option and enter the obtained activation key
directly in the Activation Key box.

Artisteer Activation X

Produck: Artisteer

Version: 3.0.,0,37990

License Key: 1111-1111-1111-1111-1111
Installation code: 0000-0000-0000-0000-0000

¥ Auto-activation through the Internet

Ackivation key:

Ohbtain Activation key ak
htbp s S, artiskeer . com)?p=az

& Help Activate Cancel
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Creating a basic design

Creating a design with Artisteer is as easy as 1-2-3:

page

& | QFiter ¥ @ © Undo erede [ WordPress Theme ~

Colors & Fo Sheet

i Menu

Ideas \ Layout Backgrounc Header

ks‘
£ A Suggest Fonts @ Suggest Sheet

% Suggest Layout ﬂz[ Suggest Sidebar
I\Element Ideas

Suggest Design

Ideas |

Articles

E Suggest Colors |:| Suggest Background Ql] Suggest Header
=7 Suggest Menu
[Z3] suggest Article Design ~

Untitled - Artisteer 3 Standarc
Sidebar

Y

Styles WordPress
Theme ~
\ Export 1% |

Vertical Mer\ Buttons Footer

1 . Suggest Design

2 . When you find a

i | to fi
is a tool to find a good design idea you

basic theme idea and .
may want to adjust some

the great place to . .
g P design elements like

start from.

| —
 Home

Vertical Menu

colors, fonts or page

Menu ltem background separately.
The corresponding
“Suggest ...” buttons

(%2

will help you with this.

News

Menu ltem

3. Click Export

to save the created

design as a

WordPress theme,
HTML template or

any other format

you like.
d,

| Author Admin | Edit

Lorem SuPerscript gojor

consectetuer adipiscing
link, hovered link conse
adipiscing elit. Quisque
Aliquam sit amet felis. Mauris sem
laoreet dictum, quam diam dictum
placerat elit nisl one more link in qi
annue nede _malestie eaet _rhancu

In most cases, nearly everything you need to do can be started by clicking the Suggest Design button. This

creates a random design that you can either work on or click again to see another suggested design.
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Further Customization

Artisteer is a powerful tool with great customization capabilities. After you find a good design idea you may
go into a specific tab and adjust the design to match your needs. On each tab there are several options for
customizing specific elements.

Note: Some options may not be available depending on settings and layout choices you have made in other
areas. Also, all of the advanced options are not available in the ‘Home’ edition of Artisteer.

That is not all! If you can’t find the option you want in specific list then click on “More...” to get full

customization capabilities:

Here is an example of how it looks for the Sheet tab:

6 | [Fiter 7 [ O Undo er:=co [RWordPress Theme ~ Untitled - Artisteer 3 Standard Edition
. Ideas Colors & | Layout Backgrotx Sheet Header Menu Articles  Sidebar Vertical I\l Buttons Footer <« 'L'\}‘;' Suggest
Q\ | (o i | | & width~ [ J]radivs - (] Transparency »
=4 ] - [ Margin ~| &} shadow ~ (@) Border -
Suggest Sheet = =
\ \ || No Margin [ _
Ideas ‘ She |0 ' :
S ‘ I No Outline — e
Top Margin
F (——j 30 pixels
Even more
Head"ne 50 pixels options here...

4 More Top Margins...
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Layout
Shyle
- S CE X

T Minkmum width: —E—nc
T Masinum width: —E—m

T o[ 0in

£ Top Dutine: [ res -]

T Paddng: e— [ 0:m
(BlFreeu ook | camel | prevew |
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Many advanced options and settings are included in dialog boxes which can be accessed by clicking a

small arrow button ™ to the right of the group caption.

= JFil-~
L#” Borde
Menu Bar

-

Menu Bar F
The user interface for a typical dialog box includes the following:

o Dialog caption indicating what kind of options are available in the dialog

e The list of the option groups located in the left pane of the dialog box. Click on the group to expand
its options.

e Options and settings available for the selected group.

e Preview checkbox to view the results of the setting automatically as they are changed.

e Preview button to display the result of the settings on the page.

e OK button to apply the settings and close the dialog box.

e Cancel button to discard the changes and close the dialog box.

An example of a dialog box is provided in the picture below.

Menu Cptions )

Layout Merws Bar
MeruBar

& Meru Ba Tewws Pasbor

i Meru Bar Tesure B8 cradient contrast: = [HE
Item

CY T g _ | Traraparancy: = 05 %
Subibem

o Praiess oK Cancel Freviss

Most of the dialog boxes contain settings that can be changed using slider bars. Usually these are settings

for the width, height, opacity, transparency and other range values. Position the pointer over the slider and
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drag it to the right or left to increase or decrease a specific option’s value. The selected value will be
displayed in the box next to the slider bar. You can also enter the desired value directly in this textbox.

Use the "Preview" button or "Preview" option available at the bottom of the dialog window to preview the
changes.

If the "Preview" checkbox is ticked, the changes will be immediately displayed on the page as you drag the
slider. If you type the value directly in the option box, click outside the box to have the value applied to the

page.

If the "Preview" option is unchecked, press the Preview button to see the changes on-screen. It will help

you easily achieve the desired look of your page.

Finally click OK or Cancel button to commit or discard your changes.
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The colors on computer monitors are made up of varying amounts of red, green and blue base colors.
Depending on how much you take from each base color, you can create any of the colors which a monitor
can display. For example, a mix of red and green produces the yellow color, a mix of red and blue —
magenta and so forth. Mixing all three base colors with full intensity produces the white color while the
absence of all the components returns the black color.

The values for red, green, and blue base colors are usually specified using a scale from 0-255 (decimal),
where 255 represents 100% intensity of the color.

RGB is a convenient color model for computer graphics because the human visual system works in a
similar way. However human perception does not see colors as triplets of numbers: red, green and blue.
Instead it is quite convenient to describe colors as made up of hue, saturation and lightness (or luminosity).
This HSL scheme defines colors more naturally and can be visualized as a cylinder whose central axis
ranges from black at the bottom to white at the top with neutral colors between them. The angle around the
axis corresponds to “hue”, distance from the axis corresponds to “saturation”, and distance along the axis

corresponds to “lightness”, or “luminosity”.

Hue specifies a pure, spectral color. It is measured as a location on the color wheel, expressed as a degree
between 0° and 360°. In common use, hue is identified by the name of the color such as red, orange, or

green.

Hue | Color

red
yellow
green
cyan
blue
magenta
red

OO |WIN|IFL|O

Saturation is the purity of the color. It represents the amount of grey in proportion to the hue, measured as
a percentage from 0% (grey with no hue at all) to 100% (fully saturated color). On the standard color wheel,

saturation increases from the center to the edge.

Luminosity (Lightness): is the relative lightness or darkness of the color, usually measured as a

percentage from 0% (black) to 100% (white).
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Artisteer allows you to work with both HSL and RGB color schemes. The desired color can be specified in
the Color Selector dialog.

Color Selector dialog

The Color Selector dialog is displayed when you select "More Colors..." button in one of the color option

dialogs.
Color Selector X | Color Selector X
Luminosity | Hue Luminosity =~ Hue L

Hue: Hue:
Sat: Sat:
Lum: H Lum:
P
Green: Green:
Blue: Blue:

Hex: Hex:

V Preview 0K | | l:ancr| V' Preview oK | | Cancel gJ

The Color Selector dialog lets you select the desired color and adjust the hue, saturation, and brightness of
the color. With the help of the Color Picker tool you can extract and apply the colors from any spot of the
template. It is widely used to transfer the colors from the inserted header image to the Sheet and other
template items color.

Color Selector

| ‘Luminosity-H Hue |

new
D O ; |
current ‘
= P
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There are Luminosity and Hue tabs available in the dialog. Both tabs have a color selection area (color

palette) where you can move a slider until you are satisfied with the color.

On the Luminosity tab there is a special luminosity slider. This slider lets you increase or decrease the

brightness of the color from zero at the bottom to 100 at the top.

With the luminosity selected, you can go to the color palette and drag a small circle picker horizontally and

vertically to change the hue and saturation of the color respectively.

The Hue tab contains a separate Hue adjustment slider. Moving it all the way from red (at the bottom)

through orange, yellow, green, and blue up to purple allows you to select the desired hue of the color.

Having the Hue selected, you may also move a palette color picker from left to right and from top to bottom
to additionally set the saturation and luminosity values of the color. Saturation can vary from 0% (completely

unsaturated) to 100% (completely saturated, pure color). Luminosity ranges from 0 (black) to 100% (white).

The values displayed in the right set of boxes will change to indicate the exact color settings. These values
can also be changed manually by directly entering values in the text boxes. It may be convenient when you

copy the exact color value from some other graphic software and want to use it in Artisteer.

Option Description
Hue Hue value of the color ranged from 0° to 360°.
Sat Saturation of the color ranged from 0% (completely desaturated) to

100% (fully saturated).

Lum Luminosity of the color measured in percentage: from 0 (black) to 100%
(white).
Red Decimal value for red color.
Green Decimal value for green color.
Blue Decimal value for blue color.
Hex A hexadecimal color code (usually used in HTML code).

The "Preview" option makes it possible to see the page with the selected color applied to it. Ok and Cancel

buttons allows you to submit or discard the changes made.
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Once you have settled on the basic look of your site, you can export it as a design or template which is

compatible with the type of blog, CMS, or application that you want to use.

& ([ 3File~| 2 @ ©und

Mew Ctrl=M

Tu
A " Open.. Ctrl+O
H Save Ctrl+5

H Save As..,

[
3i’j Change Template

j Export 3
iy

| F Preview In Browser »

7 1
m‘% Activation...

& l\-ﬂ Export Options...

o About Artisteer
ol

Export

%a WardPress Theme

0:‘ HTML Page
il

Site Icon [Favicon)

There are three steps that need to be followed to export the design:

Ctri+E

First, select a template which will be applied and used when viewing the page in Artisteer. Currently the

following templates are available: Website or Blog (HTML or Artisteer.net), WordPress, Blogger, Joomla,
Drupal, DotNetNuke, ASP.NET Application, and CodeCharge Studio.

Next, tell Artisteer what export option you want to use when generating the selected template. Choose the

desired Export Design option to export and save your design as individual style files.

In the Export Dialog, specify the desired template name and the folder to export your template files to. If

necessary, compress the template folder by using "Export as a ZIP archive" option. If you would like to
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modify the template in the future, check the “Include the *ARTX project” box, and your project will be saved
in the same folder as the template”.

48 Export: WordPress Theme x

File Mame:;

| Themerame |

Path:

| C:ADocuments and SettingsimsninchiliDeskiopiMew Folder - | =

Export As:
Folder

Include the *. ARTY project

© Help Expork Cancel Options. ..

"Blogger templates may be published directly from Artisteer. The “Publish” feature will upload your template
to Blogger.com and the containing images will be uploaded to Picasa, ImageShack, or some other image
hosting server, depending on your Export options. To get the template published, open “Export Template”

on the quick access toolbar and select “Publish Template to Blogger.com”.

[-..fz'JExpnrt Templatel <
% Publish Template to Blogger.com Ctrl+E
) Export Template
[@] HTML Page

'1._| Export Options...

The Artisteer “Export Template” menu for Blogger also includes the “Upload to ImageShack” feature, which

may be used for free hosting of images.
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4 Export: Export Template
Folder Mame:
Templatelames
Path:
CADocuments and SettingsimsninchikiMy DocumentsiArtisteer Te = |||

Export As: Image Location:
* Folder (- Upload ko ImageShackE)
ZIP archive Save to kemplate folder

Include the *. ARTY project

€ Help Expart Cancel Options. ..
Option Description
Name Identifies the name of your theme. It is recommended that the name
should conform to the naming conventions of the CMS used.
Path Indicates the path to the folder where the exported files should be placed.

Export as a folder

Export as a ZIP archive

Include the *ARTX Project

Upload Images to ImageShack
(Blogger templates only)

When the template is exported, a folder with the specified name
containing all the theme files is created in the specified location.

When the template is exported, a zip archive containing all the theme
files.is created in the specified location.

Saves the *ARTX project and the template in the same folder. Thus, the
template may be further customized.

A feature for web hosted websites. Uploads images contained in the

template to a free image hosting website.
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This section describes the type of projects, or templates, you can create. These appear in the New Project

dialog when Artisteer first starts.

Icon Option

=

Wehbsite ar Blog

Website or Blog

Samples

Samples

Online Samples

=y

Jnline Samples

Description
Websites and Blogs

You can edit the content in a WYSIWYG mode, export a
website as a group of HTML pages, and host your website on

the free online hosting service Artisteer.net

Samples suggest different categories of websites with typical
start-up content. There are Personal and Professional,
Business, and Community samples. Custom content may be
entered WYSIWYG-wise. Editing tools are located in the Edit
tab. Besides, you can insert links, images, cliparts, tables, and
buttons. You can also view and modify the source HTML, as
well as add/modify the web design using all the design tools

available in Artisteer.

Online samples will take you to Artisteer.com and show a
gallery with free ready-to-go templates, which can be
previewed and downloaded at the website. The fully
customizable templates are available for Joomla, WordPress,
Blogger, Drupal and DotNetNuke. They are also available

as an Artisteer project or an HTML website template.

Content Management System Templates

WordPress

=

WordPress

WordPress template option is provided for those who create
designs for WordPress websites.
After selecting this template from the Template list you have

the option to export the design as an HTML template or a
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WordPress theme.

Joomla template option is provided for those who create
Joomla website designs.
—i Joomla Selecting this option provides the possibility of exporting your

{9l design as an HTML or Joomla template.

Drupal template option is provided for those who work with the

Q Drupal CMS.
' Drupal Selecting this option allows exporting your design as an HTML

Drupal template or Drupal theme.

Blogger template option is provided for those who lead blogs in
| Blogger.
— Blogger Selecting this option provides the possibility of publishing the
Bz created template to Blogger.com, exporting the design as a

Blogger template, or an HTML template.

DotNetNuke template option is provided for those who work
*‘ with DNN.
& DotNetNuke Selecting this option provides the possibility of exporting your

LBl design as an HTML or a DotNetNuke template.

Web Design Templates
ASP.NET Application option is provided for .NET developers
creating websites in MS Visual Studio.
"—-,/H ASP.NET Application  Tpe design can be exported as an HTML template or as a

R ;ﬁﬁgﬁgn Visual Studio C# project.
CodeCharge Studio template option is provided for developers
L.r_'”‘_i and designers who use the CodeCharge Studio development
S CodeCharge Studio tool for creating web applications.
C':'gfﬂizrge After selecting this template from the Template list, you have

options to export the design as an HTML template or as a
CodeCharge Studio Project.
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Export Design as an HTML Page
Artisteer generated templates of any supported Content
[@ HTMLPage Management System and Application may be exported as
HTML Page HTML pages. Such templates are a source of professionally

developed design, which may be useful for web designers.

Follow these steps to export a design as a WordPress theme that can be applied to the existing WordPress

installation:

Pick a WordPress template on Artisteer start-up. Select “WordPress Theme” at the Quick Access Toolbar.

Press Ctrl + E to invoke the Export dialog.

Specify the name of the theme and the export destination.

Choose the export model: to export as a folder or as a ZIP archive.
Tick off the box to get the *. ARTX project included.

After the export you will obtain WordPress-specific theme files that can be located in the theme folder on
the server and easily applied to WordPress websites. The path to the theme folder in the WordPress
system usually looks like WordPressFolder\wp-content\themes\ThemeName, so you can simply upload the

exported theme files into that folder.

To apply the new theme to your website, login to the WordPress Administration Panel, navigate to the
Presentation tab (WordPress version 2.6) or to the Appearance-> Theme (WordPress version 2.7) and

activate this theme.

The generated WordPress themes are widget ready and compatible with WordPress version 2.7 and

higher.

Tips and Tricks:
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1. WordPress theme localization

When exporting themes, Artisteer automatically includes several language files obtained from the
WordPress Website at

Specifically French, German, Italian and Spanish translations are exported by Artisteer in the WordPress

compliant file naming format:

<country>_<lang>.mo

For example German language file is: de_ DE.mo

To include a different or additional language in your Worpdress theme, please find and copy the desired
language files into your specific WordPress theme folder. You can find the additional language files in your
default theme folder "<WordPressFolder>\wp-content\themes\default”, or on the WordPress Website at

http://codex.wordpress.org/WordPress_Localization

To select a different language than your current WordPress language, change the "define" function in the

wp-config.php file, for example:

define (WPLANG', 'de_DE))

To edit translations for your language please download and install the Codestyling Localization plug-in from

Then in WordPress administration, select Manage - Localization.

Follow the steps below to export your design as a Joomla template:

Pick Joomla template on Artisteer start-up. Select “Joomla template” at the Quick Access Toolbar or Press

Ctrl + E to invoke the Export dialog

Specify the name of the template and the export destination

Choose the export model: to export as a folder or as a ZIP archive.
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Tick off the box to get the *. ARTX project included.

After the export you will obtain a set of Joomla-specific files that can be located in the theme folder on the
server and easily applied to Joomla websites. The path to the theme folder in the Joomla system usually
looks like JoomlaFolder\templates\ThemeName so you can simply copy/upload the exported theme files
into that folder.

If your theme is exported as a ZIP archive, log into the back-end of your Joomla installation, go to
Extensions = Install/Uninstall, choose "Upload Package File" option in the "Extension Manager", type the
path or click the "Browse..." button to select your zip file and click the "Upload File & Install" button to

upload and install the theme.

Once the theme is successfully installed, you can activate it by selecting Extensions - Template Manager

from the drop-down menu and assigning your template as the Default Template for the website.

Note, the generated Joomla themes are compatible with Joomla version 1.5 and higher.
Tips and Tricks:
1. Joomlalocalization

Joomla provides an internationalization feature, and currently supports 50 languages. Language packages
are available for download at:

Joomla uses three language packages: one for the front end, one for the administrator and one for
installation. Using all three packages is not a prerequisite. Feel free to download only the necessary

packages and customize the language settings to serve your needs.

If there are no packages for your language, you can create them manually following the instructions
provided in the Joomla documentation:
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2. Apply Artisteer style to Joomla menu

To apply an Artisteer menu style, you should locate your menu in the "user3" module position. Go to
Extensions - Module Manager - select the Menu (e.g. Top Menu) > click the Edit icon on the toolbar >
Details section - select "user3" in the Position listbox.

3. Multilevel Menu in Joomla

It takes three steps to create a multilevel menu in Joomla:

Activate a multilevel menu for your template in Artisteer (Menu - Subitem - Levels - Multilevel).

Locate your menu in the user3 module position in Joomla Administrator.

Go to Joomla Extensions - Module Manager - select the Menu (e.g. Top Menu) - click the Edit icon on
the toolbar - and set "Always show sub-menu Items" in the Module Parameters dialog to "Yes". If

necessary, you can also specify the number of sublevels using the "Start Level" and "End Level" options.

Follow the steps below to export a design as a Drupal theme:

Pick a Drupal theme on Artisteer start-up. Select “Drupal template” at the Quick Access Toolbar or Press
Ctrl + E to invoke the Export dialog.

Specify the name of the template and the export destination.

Choose the export model: to export as a folder or as a ZIP archive.

Tick off the box to get the *. ARTX project included.

After the export you will obtain a set of Drupal-specific theme files that can be located in the theme folder on
the server and easily applied to Drupal websites. The path to the theme folder in the Drupal system usually
looks like DrupalFolder\themes\ThemeName, so you need to upload the exported theme files to that folder.

If your theme is exported as a ZIP archive, extract the archive into the "themes" folder on the server.
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After that, you can activate your theme in the Drupal Administration. For this, log into the administration
area, navigate to Administer - Site Building = Themes, check the "Enabled"” box as well as the "Default"

radio button next to your template and click the "Save configuration" button.
Tips and tricks:
Naming standards

Use only letters (preferably lowercase), numbers, and underscores in the theme name. No special

characters, spaces or hyphens are allowed.

If you work with Drupal version 5, be sure not to rename your template folder after the export. Otherwise,

some functions will be undeclared and the design will look corrupted.
2. Drupal Localization

The localization feature is described in the Drupal documentation:

Blogger templates may be published from Artisteer directly to Blogger.com or exported to any folder on your

computer.
To publish a template to Blogger.com:

Pick a Blogger template on Artisteer start-up. Select “Publish template to Blogger.com” at the Quick Access
Toolbar or Press Ctrl + E to invoke the Publish dialog

Enter your username, password, and blog and click “Publish”. Your password will be automatically

remembered.

The images present on the Blogger template will be automatically published to Picasa Web Albums,
ImageShack, or some other image hosting server, depending on your Export options. To change the
image hosting provider and see the possible export adjustments, go to Export Options (Publish template to
Blogger.com-> Export Options) and specify the suitable export options before publishing the template.
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To export a Blogger template:

Pick a Blogger template on Artisteer start-up.

Find “Publish template to Blogger.com” at the Quick Access Toolbar and open the Export menu by clicking

the arrow at the right side of this button. When the Export menu opens, select “Export template”

Specify the name of the folder and the export destination.

Choose the export model: to export as a folder or as a ZIP archive. The default option of Artisteer for

Blogger is to export the template as a folder.

Specify the image hosting provider: uploading images to ImageShack or saving them to the template folder.

The default option of Artisteer is to upload images to ImageShack

Tick off the box to get the *. ARTX project included.

Pick a DotNetNuke skin on Artisteer start-up. Select “DotNetNuke Skin” at the Quick Access Toolbar or

Press Ctrl + E to invoke the Export dialog

Specify the name of the folder and the export destination.

Choose the export model: to export as a folder or as a ZIP archive.

Tick off the box to get the *. ARTX project included.

Follow these steps to export a design as an ASP.NET project that can be opened later in Visual Studio.

Pick an ASP.NET Application on Artisteer start-up. Select “Visual Studio C# Project” at the Quick Access

Toolbar or Press Ctrl + E to invoke the Export dialog.

Specify the name of the project folder and the export destination.
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Choose the export model: to export as a folder or as a ZIP archive.
Tick off the box to get the *. ARTX project included.

When the export is completed, a new C# project will be created in the specified location. Open it in Visual

Studio using File > Open Website option and examine the files created. You will see:

e Master Page that defines a site's overall layout and contains a set of content placeholders such as
HeaderContentPlaceHolder, TitleContentPlaceHolder, SheetContentPlaceHolder etc.

e Content Page called Default.aspx that has several content blocks and default pages
(DefaultHeader, DefaultMenu, DefaultSidebarl) included into it. This page is generated as an
example for you to see how a finished content page may look like.

e CSS files that define the design of the pages.

e A set of other files necessary for the Visual Studio project.

Feel free to modify the project files the way you want and enjoy!

Follow these steps to create a design that can be applied to CodeCharge Studio projects.

Pick a CodeCharge Studio Project on Artisteer start-up. Select “CodeCharge Studio Project” at the Quick

Access Toolbar or Press Ctrl + E to invoke the Export dialog
Specify the name of the project folder and the export destination
Choose the export model: to export as a folder or as a ZIP archive.
Tick off the box to get the *. ARTX project included.

When the export is completed, a new CodeCharge Studio project will be created in the specified location.

The following pages will be added to the project:

e PageTemplate
e Header

e [ooter
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e Main
e About

PageTemplate is an essential page that will be used as a basis for creating all the new pages within the
CCS project. This functionality is achieved using Project Settings->General->New Page Template option.
PageTemplate includes the Header and Footer pages that are used to add page background, sheet, header
and menu styles to the pages. Thus all the newly created CCS pages will have a page background, sheet,

header and menu styles automatically applied to them.

Note, the Artisteer-generated styles cannot be automatically applied to CCS forms, buttons, and other

blocks on the page.

To add a style to these components, you can consider one of the following solutions:

e Open CCS Style Builder (Tools - Styles) and add a new style that looks similar to the style
generated by Artisteer. Use this new style for CCS forms and controls.

e Modify a CCS page template to add the Artisteer styles manually. In that case, do not select any
style when creating forms and controls in CCS. Switch to HTML mode and modify your page
template manually by adding the Artisteer classes and the necessary html tags. A sample html
code snippet is provided on the Main page so you can review it and modify CCS page templates

accordingly.

The sample code below demonstrates how to apply the Artisteer-generated styles to a Record form on a

<I-- BEGIM Record countriesSearch -->
<form id="countriesSearch" method="post" action="{Action}" name="{HTMLFormMName}" >

<div class="Block">
<div class="Block-body" >
<di ss="BlockHeader" >

éhz—}éearch
zdiv class

'BlockContent" >
'BlockContent-body" >
<table class="Record table" cellspacing="0" cellpadding="0">
<1-- BEGIM Error -->
<tr class="Error">
<td colspan="2">{Error} <ftd>
<ftr=
<1-- END Error -->
<tr class="Controls">
<td><label for="countriesSearchs_country_name">Country Name </label><ftd>
<td><input type="text" name="{s_country_name_MName}" value="{s_country_name}" maxlength="40" size="40" id="countriesSearchs_country_name" /></td>
<ty

<tr class="Bottom">
<td colspan="2" align="right">
<!-- BEGIN Button Button_DoSearch -->
<input class="Button" name="{Button_Name}" type="submit" value="Search" alt="5earch" id="countriesSearchButton_DoSearch" [ =
<1-- END Button Button_DoSearch --><ftd>
<ftr >
<ftable>
<fform:>
<fdiv =< fdive<fdive</dive

£I-- END Record countriesSearch --> -
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CCS page. The unchanged HTML code is shown in black, the removed code lines are crossed out and
highlighted in red, and the lines added to the code are highlighted in blue color.

Pick any template (WordPress, Joomla, Drupal or other) on Artisteer start-up.

Go to the Quick Access Toolbar and open the Export menu (the arrow at the right side from the “WordPress
Theme”, “Joomla Template” or other template button). When the list of export options appears, select
“HTML Page”

Choose the export model: to export as a folder or as a ZIP archive.

Tick off the box to get the *. ARTX project included.

The resulting template will contain markup, styles and graphics that are necessary to apply the design to

any Web page.

The Export Options dialog box appears when you select Export - "Export Options..." from the Main Menu
or use the Export - "Export Options" command on the Ideas tab or on the Quick Access Toolbar. The

dialog provides a set of options for exporting templates from Artisteer.

The available options are explained below. Most of them are optional; no value is assigned when a field is

left empty.
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Export Options

G [] Properties
it | W aberrnark
__| Footnote
i[5 C55 Options
&Y wordPress

Properties Tab

| Properties

t"?* Author name:
s Author URL:
] Template version: 1.0
== Template URL:
& Tags; widgets, walid ¥HTML

'_?’ Descripkion: Artisteer-generated theme

The Properties tab describes the information to be used by Artisteer to generate the style sheet header and
the metadata information for the theme. This information is used by the CMS, if your CMS supports such

functionality.

Option
Author Name
Author URL
Template Version
Template URL
Tags

Description

WordPress Tab

Description
Identifies the name of a person or organization creating the design.
Provides a reference to the Author's website
Identifies the Version Number of the template.
Specifies the location of the template on the web.
Specifies the keywords associated with the theme.

Provides additional information about the theme.

The WordPress tab contains home page Menu Item settings, which specify whether Artisteer should create

a special menu item pointing to the homepage (front page) of the website. Menu Source settings define

which data categories or pages, are used as a source for horizontal and/or vertical menu.

Option

Description
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Visible ltem

Item Name

Menu Source

Watermark Tab
Option
Show Watermark

Watermark Text

Footnote Tab

Option
Include a backward link to the
author

Include a backward link to the
CMS and the Artisteer

CSS Options Tab
Option
CSS prefix

page

If this option is checked, Artisteer creates a special Home Page Menu Item
which is highlighted when the website’s front page is displayed in a
browser. If the front page is not set, this menu item points to the list of

posts.

If "Visible Item option is unchecked, no menu items are created by
Artisteer. The whole menu is built from the list of WordPress pages. If the
front page is specified in WordPress settings, you will see the menu item
that corresponds to that page added and highlighted in the menu. If the
front page is not set, no menu item is highlighted by default when the list of
posts is displayed in a browser.

Specifies the caption of the menu item pointing to the home page.

Defines which data categories or pages, are used as a source for the

horizontal and/or vertical menu.

Description
If checked, the Watermark Text will be repeated throughout the page.

A text to be displayed across the page when the "Show Watermark"

option is enabled.

Description
When checked, the above-defined author name will be displayed in the
page footer.
When checked, the CMS name and Artisteer name will be displayed in

the page footer.

Description

The CSS prefix exists to avoid conflicts with CSS classes of 3d-party
modules. The “art-“ value is a default CSS prefix in Artisteer, which may
be modified. It may contain only alphanumeric symbols and dashes (A-z,

0-9, “-”, “ ") and should start with an A-z letter.

artisteer.com | page 38



i 39
Artisteer

Web Design Revolution page

Additional CSS styles You can enter custom CSS styles here. They will be embedded in CSS
file generated by Artisteer.
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Ribbon

Let’'s have a closer look at the Ribbon bar. It is divided into different distinct categories used to customize
your design. Moving from left to right, we begin with the overall idea and layout of the site. As we move to

the right, we become more focused on specific parts of the site such as blocks and buttons.

& | (Fiter = [@ © Undo ™dRedo [FWordPress Theme + Untitled - Artisteer 3 Standard Ec

Ideas | Colors & Fonts  Layout Background Sheet Header Menu Articles Sidebar Vertical Menu Buttons Footer
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The Ideas tab is a great way to quickly envision your Website design right before your eyes.

Edﬁuggest Colars JSuggest Background :'IISuggest Header |_-¢’| .

A4 Suggest Fonts  |[]| Suggest Sheet = Suggest Menu :
Suggest Design Styles
2L . |.T‘_é| Suggest Layout |J=| Suggest Sidebar DSuggestAr‘ticle Design t'l'.ll,

Ideas Element Ideas

Let Artisteer create the design for you. The Suggest design feature is best used at the beginning. It allows
you to see the various designs available and helps you determine which styles and themes you like. You

can tick the desired style(s) in the Styles checkbox and Artisteer will suggest templates for these styles.

iy
Suggest Design St!'iles
Ideas x
Suggest Style
General
Corporate

¥|  Ornamental

Glamour

You are able to make adjustments to many individual components when brainstorming ideas for your Web

design:

Possibly the font doesn’t match the layout of the site or the buttons don’t match the navigation. By making

these adjustments, you can get closer to the look that you want to achieve.
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Mew Project
Websites and Blogs

E =

Website or Blog Samples

The Home Tab appears on the Ribbon bar if you select Website or Blog or Samples in the Artisteer
startup dialog. The tab is a platform with basic options, where you can choose a generated design, add and
remove web pages (posts, blocks), export the whole project (content and design) as an HTML website or

publish it to Artisteer. Net - a free WordPress based blog tool and publishing platform.

Artisteer.net provides:

e Managing content right in Artisteer (WYSIWYG)
e Free wordpress-based CMS & web hosting
e Exporting HTML websites

Thus, the process of creating a website may be completed in four steps. 1. Selecting “Website or Blog or
Samples” > 2. Adding and editing content - 3. Adjusting the template design - 4. Publishing the website

to a custom Artisteer.net account.

-

Create Website x

5@ Artisteer.net

Specify Title and Domain For the new website,

Title: | My Blog |
Ciomain: | myblog| | .artisteer.net
¥ Help Mk Cancel
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The features on the Ribbon bar are arranged in three groups: Design ldeas, Website (adding content),
Export /Publish (offline/online)

Home Edit  Colors & Fonts Layout Background Sheet Header Menu Articles Sidebar Vertical Menu EButton

EiSuggestColors | Suggest Background .v:‘/ H_;aj %Newpost o
S

74 A4 Suogest Fonts  EJ| Suggest Header L =] New Block " 4
Suggest Design = Styles Mew : Export Create
% Suggest Layout Suggest Menu - Page ~ La Delete Page HTML Website + Website «
Design Ideas Website Off-line On-line P

Now let us look at each group in more detail.

Design Ideas

The Suggest option may be applied to the whole template or to its
components, such as Colors, Fonts, Layout, Background, Header, and Menu.

Adjust the design in the appropriate tabs.

Suggest...
You can also set the style criteria for a suggested design. Use Styles option
described below.
[ The Styles option provides a list of suggested styles. Select all styles or
' / deselect them to choose the definite style (tick the checkbox).
Styles
Website (adding content)
You can add new pages, child pages, posts, and blocks. Click the New
Page to add a page or a child page. The website map located at the left side
= of the preview window helps to move through the website. Rename the
j. created page by selecting the title and pressing F2. Add a block or a post and
New Page begin typing the content or paste a ready article. The toolbar of the Edit Tab

will be automatically enabled to help you style the text and add photos, links

etc.
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Export HTML
Website

L o

Create Website

Edit

Export /Publish (offline/online)

You can export the created HTML website to a folder (or an FTP folder) on
your computer without publishing it. Click Export HTML Website to enable the
export dialog, type the folder name, and indicate the destination on your

computer. Select the .zip folder format if necessary. Please Note that

websites created in Artisteer cannot be imported and modified in the software.

To continue working with the created website in Artisteer, save your Artisteer

project by ticking the appropriate checkbox in the export dialog.

This option provides the ability to publish a complete website, a theme or
content. If you do not have an Artisteer.net account, select Create Website in
the list of options and specify the blog title, domain, user name and e-mail
account. The link to and administrator account
data will be sent to the provided e-mail address. The Create Website icon will

change for Publish icon.

Select one of the suggested Site Icons or Insert Icon from file

Press Ctrl +E for quick publishing.

Specify the Export Options (Properties, Watermark, Footnote, CSS Options,
and FTP Server). For more information see Quick Access Toolbar - Export

Options.

This option opens the website in a browser

The Edit option opens the website in the Artisteer.net administration mode.
This option becomes active after publishing your design or content to an
Artisteer.net account. The Graphical User Interface (GUI) of the

administrative panel in Artisteer.net is similar to the Artisteer Ribbon bar.

page
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The Edit tab appears on the Ribbon bar if you select Website or Blog or Samples in the Artisteer startup
dialog. The opened tab consists of an editing toolbar and an interactive preview window, providing the
ability to add, edit and remove the content in WYSIWYG mode. You can also add hyperlinks, images, tables
and buttons as well as edit the source HTML. This means you have all the tools for creating websites from

A to Z in one software. Click anywhere on the content area to enable the Edit toolbar.

The Ribbon bar options of the Edit tab are arranged in five groups: Clipboard, Style and Font, Paragraph,

Insert and Source. Click the content area to enable the Edit options.

Home Edit = Colors & Fonts Layout Background Sheet Header Menu Articles Sidebar Vertical Menu E

= — a— = = [ Bl =
Paragraph =~  Verdana -3 - Ha é: +E 3+ % | = £ e [o]4 i
=] B e i
o z - ab@ == = = F F
Pa'ste (B| 7 U A x, x é e 14 == == Hyperlink Image E#p' Ta?le Button | HTML
Clipboard Style and Font Paragraph Insert Source

The Clipboard provides standard cut, copy & paste options for embedding text in the content area. Style
and Font suggests basic typography settings such as font family, size, style, quotes and effects to give the
text a more professional look. Paragraph options help to adjust the bulleted lists, indentation and

alignment.

The Insert group allows adding and styling hyperlinks, images, clip art, tables and buttons. Click the
appropriate button to insert an object. Selecting the inserted image, clip art or table in the content area
activates additional Edit Image/Clip Art/Table options, which appear at the right side of the Edit tab toolbar.

el ] . (?} £1= position -
] ok -
% B udd ' = Border Width ~
Hyperlink Image Clip Table Button HTRIL = .
Art - - &5 Options...
Insert Source Edit Image
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You can adjust the Position (in line with text, in left, in right), Border Width and other Options (source, size,

alt text, margin) of the inserted image/clip art.

-

Add or Edit Image X
E' Irnage Image
&l source: | images/preview jpg =
T Size: & 00 5| %
E2 alk Test: | an image |
EE position: | In Left -]
5 Margin: = pix
O sorder: S pix

The basic Table options include inserting, deleting & moving columns and rows, adjusting Border Width and

splitting cells.

¥ Insert~ | = Border Width ~

B Delete ~ | [ split Cells

EH Move~ | 1} Options...
| Edit Table

The advanced options contain Table (width, margin, cell padding) and Column (width) settings.

-

Table Options

] Table Table

Cal
o = wa 6

ﬁ Cell padding: i pie
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r

-

page
To insert a hyperlink specify the link title (Text), Address, Target (optional), and Screen Tip (optional).
Add or Edit Hyperlink X
@ Huperlirk Hyperlink
A Teut: ||ink1 |
=2 address: |,|'new-page-2 ||E|
% Target: -
\%ﬁ 2creen Tip: _self
_top
_hlank
_parent
To insert a button specify the link title (Text), Address, Target Frame, Screen Tip and Access Key.
x bl

Add or Edit Button

k] Bukhan

Button

A Texk:

=3 Address:

@’ Target Frame:

@ ScreenTip:

@ Accesskey:

link 1

| Inew-page-2
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By selecting the HTML button on the Ribbon bar, you can also edit the HTML source for the content you

have added to your page (e.g. table).

Edit HTML

<p>Enter Page content here...</p>
<table class="art-article” border="0" cellspacing="0" cellpadding="0" =style="width:100% ;">
<thodys
<tr class="even":>
<tdr<br Sl tds
<tdr<br Sl tds
<tdr<br Sl tds
<tdx<hr feed s

O -1 @ b @M
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The Color & Fonts tab provides the ability to change the colors and fonts of the template.

€ | JFiler ¥ [ Y uUndo gy wordPress Theme ~ Untitled - Artisteer 3 Star

Ideas Colors & Fonts Layout Background Sheet Header Menu Articles Sidebar Vertical Menu

% 0 RO Y T o4 A

Suggest Colors Color Themes -jc';:uj- Adjust = Suggest Fonts Font Sets Typography Font Scale

- -

Ideas | Colaors | Paints M | Ideas | Fonts M |

To change the colors of your template, select a Theme from a variety of available color themes. Having

chosen the color theme, you may also refine the colors in your template by adjusting the overall contrast of

the colors.

In this block you have the ability to adjust the Color theme. Select one of the predefined adjustment

schemes or customize the color theme by adjusting the Colors options.

O Adjust *|
Basic <
.l:l. Medium E|
Normal
B uoht
-
——— -

1 Adjust Options...

Clicking on the “Adjust options...” will open the Colors option dialog where you can customize:

e Luminosity

e Saturation
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Enter the values or drag the sliders to the right or left to increase or decrease values.

Calors

[t adjust | Adijust
| Luminosity '—07 %
Wl Saturation: V—U' %

Adjust Color Options

Set the color luminosity. Luminosity refers to the whiteness or intensity of a

color. Luminosity for any one color will range from pure white though to black.

il
LUIReEE) The supported values are from -100% to 100%.Where 100% and -100% refer
to the highest and lowest of the RGB components.
Set the color saturation. Saturation refers to the amount of grey in a color, and
determines how vivid it is.
i
Saturation

The supported values are from -100% to 100%.Where 100% means a large

amount of the grey.

Select from a wide variety of font themes to match the overall look and content of the site.

T 4 A&

Font Sets Typography Font Scale

L L -

Fonts P

The Fonts section includes the following functions:

e Font Sets

e Typography
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e Font Scale

Font Sets allows you to change the text and heading fonts. You can choose one of the Artisteer standard

font sets or create your own custom font scheme. Just click on the Edit Font Set... button in the Font Sets
list.

The Typography option allows you to select one of our typography styles or create your own custom style
design. Just click on the Edit Typography... button in the Typography list.

Typography x

Select style to edit

»

Article Contat
A4 Default
ﬂ Text
&3 Link
=% Wigited Link
= Howvered Link
H Headings
H1 Heading 1
H2 Heading 2
H3 Heading 3
H4 Heading 4
Hi Heading &
He Heading B

Preview:

Madify...
AaBbYyGgLLj

55
font-Family:+Conkent; Fonk-size: 1:3p:x

Close

In the opened Typography dialog you can change any text object by selecting the object and clicking the
"Modify" button. The Modify dialog allows adjusting the following Font settings:

e Font Family

e Font Style

e Font Size (in pixels)

e Add or remove Effects

e Adjust Character Spacing
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Site Default - Text x

Fant
Font Family Font Style Font Size [px]
+Cartent Regular 12

[Default Font] & | |[Default Style) (Default Size] -
Arial [Headings] | |Fegular g
Arial [Content) Italic 9 E
Aial EBold 10
Arigl Black Eold ltalic 11

Comic: 5 ans M5 12

Courier Mew )1 13 o
Effects

A [H] Underline s [B] Small Caps

A [H] dverline Aa [B] All Caps

A [B] Stikeout

Character Spacing
Spacing: i By: Defaulf = =

Fant Preview

AaBbYyGoLLlj

V| Preview Ok Cancel

For the Footer Text, Blocks Text, Article Headline Text and Article Header Text you can also modify the
Paragraph settings such as:

e Alignment
e [ndentation

e Spacing

Article Content - Text x

Fort | Paragraph

Indentation:

Left Side: P Indent First Line:

Right Side: b *= [Defaul = pu
Spacing:

e o

Before: = p# Line Spacing:

word: 4 p
Preview

Paza guaph Paza graph Paza graph Paza quagh Paa guaph Paza gk Paza gaghiPaza graph Pazs aph Pazs gaph Paza graph.
Paza puaph Paza graph Paza gaph

Paza guaph Paza graph Paza gaph Paza guagh Faga aph Paza gaph Paza gaph Pasa graph Paza graph Pazs paph Paza gagh
Pazaguaph

Paza guaph Paza gaph Paza graph Paza guaph Paga guaph Paza uaph Paza gragh

V! Prewview ok | | Canicel
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The Font Scale option allows you to change the overall font scale. Using the Options... button, you can

define a custom font scale. This scales all of the text on your page based on the font size defined for each
text item.

Font Scale
Font Scale -
80% [ i
Aa Typograpty X
a5 Ilh COptions Options
Aa
— | | At FontScae —{——— [ [§]=
1 Options... —
Typography options
At Set Font scale for all text. The supported values are from 50% to 200%.
Font Scale 200% is the biggest font scale value.
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The layout tab is where you can quickly change the overall positioning of elements on the page.

Layout

IT_; — o
Suggest Layout

( Ed Header ~ [ Margin - 2 T Margin -
= T+ Marg O Marg =
— |, | = Menu T ]E]Padding'

i Sheet Width Columns Column Block
i Footer~ - *  Width~ Pasition ~
Ideas Design Layout Sheet Layout ] Content Layout N Elocks

The sequence of feature groups in the Layout tab starts with Design Layout, and is followed by Sheet

Layout, Content Layout and Blocks.

Design Layout

lfl Layout gallery shows and suggests popular layouts, which are grouped based
on the position and style of the Header, Menu and Footer.
Gallery
wf{‘ This option regulates the width of the Header, which may be set to the size of
the Sheet, or the size of the Page.
Header
= This option regulates the width of the Menu, which may be set to the size of
the Sheet, or the size of the Page.
Menu
i} This option suggests three Footer positions: Inside the Sheet, Sheet width, and
Page width.
Footer
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Sheet Width

=

Margin

Padding

Columns
Column width
=

Margin

page

Sheet Layout

Artisteer provides both Fixed and Fluid (absolute and relative) sheet width
ranged from 600 - 1000px (60 - 100%). A custom sheet width may also be
specified using the More Sheet Widths option.

Margin regulates the distance from the top of the page; the larger the margin,
the lower the Sheet appears. You can select a margin from 0 to 50 px. A

custom margin may also be specified using the More Top Margins option.

Padding regulates how much blank space is left inside the Sheet. You can
select from 0 to 15 px. A custom padding may also be specified using the
More Paddings option.

Content Layout

The Columns option defines the number of columns and their position on the
Sheet. You can choose between one, two or three columns; the sidebar(s)
being at the right, left or at both sides of the main (content) row.

Column width regulates the width of the sidebar (s). You can choose from 200
- 275 px width (15 — 30% for Fluid Sheet), or you can specify a custom column
width using the Width Options.

Margin defines the distance of columns from the top of the content area. No
Margin, Top Margin and Negative Margin are the available options. A

Negative Margin places the columns above the top of the content area.
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Blocks
L{g Block position assigns blocks to a certain place on the Sheet. Block names
{s] . .
: vary, depending on the Content Management System you are exporting your

. template to. There are such blocks as Search, Vertical Menu, Categories,
Block Position _ Lo
Archive, and Bookmarks for WordPress. The suggested block position is

highlighted with a blue color on the thumbnails.

The Layout tab also contains two dialogs for extra customization. These are Sheet Options within the Sheet

Layout menu and Layout Options within the Content Layout menu. You can access either of these by

Sheet OpHons x
(] Laout | Layout
O Style — —
1 width: - o0 o -
2k Shadow I = | K
— =
% Top Margin: i 50 2| px
C]J Top Cutline: Yes -
EI Padding: =y 15 2| px

clicking on the Custom Values ™ icon.

Group of Options Description
Layout The Layout options are adjusted by sliders. Layout options include Width,
Top Margin, Top Outline, and Padding settings.
Style Style options include Radius, Border Width, and Transparency settings.
Radius softens or sharpens the edges of the Sheet. Border Width
regulates the weight of the border line. Transparency may smooth or

increase the contrast between the Sheet and the Background.
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Shadow Shadow adds a three-dimensional web 2.0 effect. The shadow options
include Size, Opacity, Distance and Angle that can be adjusted with
sliders.

Layout Options

Layout Optons *x

=| Colurnns Colurnns

Group of Options:

5 Top Margin:
[t)'l Top Outline:
= Column 1 width:
T cCalumn 2 width:

I Colurn 3 width:

Yes

Description

Columns The Columns option includes more sensitive settings: Top Margin and Top

Outline. Also, the width of each Column may be adjusted separately.
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The Background Tab helps to manage the design of the area outside the active content of the website (the
Sheet). Backgrounds are usually filled with colors; they are often decorated with effects and images. The
Background Toolbar in Artisteer consists of four groups: Ideas, Background, Texture or Image, and Light
Effect. Each group finishes with a dialog box for advanced customization. Using Artisteer design tools
provides flexibility in working with colors, gradients, images, textures, and light effects.

Eackground

o S Fill color~ | J | | From File.. ‘ | = From File...
E il Gradient - i |- 1+ Options... + | 1 Options...
Suggest n
Background —_—
Ideas Background = Texture or Image P Light Effect ]
Background
% You can apply theme colors, custom colors, or pick up a color from any spot
on the template and add it to your custom color palette. Solid color design
Fill Color may be enhanced with gradient, texture or light effect.
- Gradient produces smooth color transitions. This option suggests different
gradients arranged according to the position, direction and character of the
Gradient color transitions. To further customize Gradient, use the Gradient Options.

Texture or Image

Texture and Image Gallery suggests different design patterns based on the
style, material, theme and position of images and textures. Colorless textures
gain the color of the filled background. Colored images and textures may be

Texture or Image Gallery modified in the Page Background Options.

This option enables inserting custom images or textures of all image formats.

Before pasting the image, specify the image position and Blend Mode.
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From File...

.LJ_

Options...

Light Effect Gallery

ke

From File...

.l‘\J_

Options...

page

Select this to further customize the Texture Options. See the Page

Background Options below.

Light Effect

Light Effect Gallery suggests various glares, which may be used as the main
or as an additional design effect. You can further customize Light Effects by

selecting ‘Options’ (see Glare in the Page Background Options).

This option enables inserting custom light effects from a file.

See Glare in the Page Background Options below.

The advanced customization options may be entered from the Options button and from the Custom Values

T jcon. The Page Background dialog includes General, Glare, Texture, Texture Position, and Gradient

Options.

Page Background

| General

| Glare
2| Testure Dption:
ﬂ Texture Pozition

W Gradient

Genetral

‘:‘ Scrolling: Fixed -
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Scrolling

(=}

—

Align
ol

Transparency

page

General

Set whether a background image is fixed or scrolls with the rest of the page.
This option is not available when "No Texture” is selected in the “Texture or

Image” list.

Glare

Set the position of a glare image. Available options are Left, Center, and Right,
to align the glare image left, center or right respectively. This option is not
available if "No Glare" is selected in the Glare list.

Set glare transparency for the Page background. The supported values are 0%
to 100% where 0% means "without transparency”. This option is not available if

“No Glare” is selected in the Glare list.

Increase or reduce the size of the light effect. This option is not available if “No

Glare” is selected in the Glare list.
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Blend Mode

¥

Transparency

K

Color Weight

i

Color Saturation
&
Contrast

=

Smart Invert

page

Texture Options

Set how the background color and background texture/ image layers are

blended into each other.
There are 3 options available:
Normal - No effect on the underlying layers.

Overlay - Blends the two layers together by changing the opacity, darkness,

and lightness of the top layer.

Soft Light - This blend mode lightens or darkens the image depending on the
color of the top layer. If the top layer's pixel is dark, then the bottom layer's
pixel is darkened. If the top layer's pixel is light, then the bottom layer's pixel is

lightened.

This option is not available when "No Texture” is selected in the "Texture or
Image” list.

Set background texture image transparency. The supported values are from O
to 100%, where 0% means “without transparency». This option is not available
when "No Texture” is selected in “Texture or Image” list.

Recolor the image or texture so that it takes on the color selected in the color
palette. Color Weight specifies how much color from the palette is allowed.
The setting is used for colorization mainly in the normal Blend Mode.
Regulate how saturated is the color from the palette applied to the
image/texture. This setting is used for colorization mainly in the normal Blend
Mode.

Make the lightest areas of the image/texture lighter and the darkest areas,
darker, thus increasing the contrast of the image/texture and making it more
visible. This setting may be helpful in the softlight/overlay Blend Mode.

Swap the lightest areas for the darkest and the darkest for the lightest. This
setting is applied in the softlight/overlay Blend Mode.
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Texture Position

Ll Set ifflhow a background image or texture will be repeated.

Texture Repeat The supported values are:

e Fill - The background image will be repeated vertically and horizontally

e Horizontally (Default) - The background image will be repeated
horizontally

o Vertically - The background image will be repeated vertically

o No repeat - The background-image will be displayed only once.

This option is not available when "No Texture” is selected in “Image or Texture”

list.
|;._' Set the starting position of a background image. This option is not available
when "No Texture” is selected in “Image or Texture” list.
Position
= Create a mirror reflection of the image/texture in vertical and horizontal
directions.
Flip
Ak Rotate the image/texture 90 degrees clockwise or counterclockwise.
Rotate
o Increase or reduce the visible size of the image/texture. When the image is set
to more than 100%, the visible image is enlarged. This setting helps to find the
Scale appropriate background image.
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Height

-

Contrast

page

Gradient

Set the height for the selected gradient type (the gradient type may be
changed using the Gradient list, under the Background command group on
the Ribbon bar). The supported values are from 1 to 1200 pixels. This
option is not available when "No Gradient" has been selected from the

Gradient list.

Increase or decrease the luminosity of the initial and final colors of the

gradient.

This option is not available when "No Gradient” has been selected in the

Gradient list.
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The Sheet tab provides the ability to change the overall positioning and look of the sheet or page. For
example, you might prefer a sheet with rounded edges instead of square edges. Or you may want to move
the sheet down a bit from the top of the page, add a shadow effect, or change the width of the borders, or

change the background transparency or the color of the sheet.

Sheet
m = width~  |_J|Radius~ |_|Transparency ~
~| T Margin~ B shadow ~ [:]Eh::uru:jvar'r
Suggest Sheet
% 15 Padding ~ &% Fil-
Ideas Sheet I

The Ribbon options are arranged into one group called Sheet. The group includes a Gallery with quick
style templates and options to manage width, margin, padding, radius, shadow, color, transparency and

border of the sheet. You can also choose between a fixed or fluid Sheet width. Fluid means the sheet

width is a percentage of the display area in the browser.

[ width =
Fixed (px) Fluid (3&)
‘ 600 pixels L | [3)‘ a0%%:
‘ 700 pixels L | I;‘)‘ 70%
‘ ‘ ‘ 800 pixels ‘ ‘{3] [:}‘ a0%

, A
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The sheet options can be customized by clicking on the appropriate button in the option list. For example, if
you want to change the Padding value click on the More Paddings... button.

E Padding =

Without Padding -

Mo Padding H
2 pixels
E il

1+ More Paddings. ..

Padding

Opening the "Sheet Options” dialog will enable you to edit the design of the sheet. Play around with the

Layout, Style, and Shadow parameters to achieve the desired result.

Sheet Options x
;I Layout Layout
92::2% = width: - ao0 -
Minirurm Width: = 700 2| px
Marirnumn Widkh: o i
T Tap Margin: = 0 D px
C}l Top Cutline: es v|
5 padding: = pix

Layout and Style parameters include the width of the sheet and its borders, the padding and the radius
values. Also, you can set custom transparency values for the sheet background. Shadow parameters
control the size, angle and opacity of the shadow as well as its distance from the sheet borders. Enter the

values or drag the sliders to the left or right to decrease or increase the option values.
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Top Margin

o

Top Outline
ji=i

Padding

Radius

a

Border Width

2]

Transparency

I=]

Size

page

Layout

Set the Sheet width in pixels, or a percent of the screen width. Supported values:
200px or 20% (the minimum width) —1500px (or 100%, the maximum sheet width).

Margin defines the distance of the sheet from the top of the page.

If the Top Margin value is 0, Top Outline may round off the top corners (when the

option is enabled) or leave them sharp (when the option is disabled).

Set the padding for the sheet content in pixels. Supported values: 0 px to 50 px, where
0 px means no padding. This option is disabled when “No Padding” is selected in the
Padding list.

Style

Set the shape of the corners of the sheet (corner radius) in pixels. Supported values:
0 px — 200 px, where 0 px is equivalent to “No Radius”. This option is not available if

you have not selected a radius for the sheet.

Set the border width for the sheet in pixels. Supported values are: 0 px — 20 px,

where 0 px is equivalent to “No Border”.

Set the sheet transparency. Supported values are: 0% to 100%, where 0% is

equivalent to “No transparency’.

Shadow

Set the shadow size for the sheet’s shadow in pixels. Supported values are from 0

px to 50 px, where 0 px means “without shadow”.

This option is disabled when “No Shadow” is selected in the Shadow list.
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Distance

Angle

page

Set the opacity for the sheet’s shadow. Supported values range from 0% (fully

transparent) to 100% (fully opaque).

This option is disabled when “No Shadow” is selected in the Shadow list.

Set the shadow offset in pixels. Supported values: 0 px — 60 px, where 0 means

"no offset".

This option is disabled when “No Shadow” is selected in the Shadow list.

Set the shadow’s offset direction.
The supported values are from -180° to 180°.

This option is disabled when “No Shadow” is selected in the Shadow list.
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The Header Tab controls all aspects of the Header, including the size, colors, fonts, foreground and
background images, flash, headline text, and slogan text. Header options are divided into the following
groups: Layout, Background, Foreground Photo, Flash, Title, and Title Style.

Header

E - =i Length - | ‘ _ v| 2 Pasition = | e [7) | Headline |Headline A- £ Pasition...
o ) ¥ . ) - —
V + [ FromFile.. | £ From File.. [ From File... 15 Size -
Suggest Header | Position _ Text TN | e Flash ) slogan  [Slogan text A- o
- I Height ™ gock - %Effacts' - 1 Options... = |'.=4 Align ~

Ideas Layout [F} Background [F] Foreground Photo [F] Flash [Fl Title Title Style

This command group includes features, which help to control the position of the Header on the page, the
size of the Header, and the location of the text block on the Header.

Layout

Assign the position of the Header: outside Sheet, inside Sheet, Without Header (the
sheet has no header)

Position
j Set the Header width to either the size of the Sheet (Sheet Width), or the size of the
Page (Page Width).
Length
= Define the distance of the Header from the top of the page, or from the top of the
Menu. If the Header is inside the Sheet, and the menu is below the Header, this
Margin option is disabled.
IJ Set the height of the header from 100 to 300 px. Custom Height is available if you
select More Heights... (see Advanced Options).
Height
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This option enables or disables the Text Block. Use this option to control the text
block background color, transparency, width (200 - 275 px), or orientation (align left,

align right)
Text Block

Advanced Options

Custom layout options can be configured using the General tab on the "Header Options" dialog

E

Header Optons x
General General
[ Foreground Phota II:I
Height: 100 -

58 Background e — - P
(& Glare S Test block: - 200 % px
D Image or Texture _

.. [} in: )t -
B Texture Position —I* Top Mardin: = P
| Bt o Top Outline: Yes - |
[ £] Flash

8.2. Background

The Background group of features is there to help you find the suitable background image, locate it on the
Header, and enhance it with various design effects.
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hf - el

Background Image

&

Position

~u

From File...

%

Effects

page

Background

This option suggests background images (grayscale and colored) of various themes
and styles: Abstract, Color Abstract, Wind Glass, Nature, Color Textile, City,

Landscape, and Clouds.

This option coordinates the size of the header with the image size. You can resize
the header to the image, resize the image to the header, or use the original image
size. Use the Align option for maximum effect.

Use this option to insert custom background files.

The Effects option is used to adjust the basic design, such as color, transparency,
radius, shadow, gradient, or including additional effects, such as glare or texture,

and using such image design features as image recolor and blur.

Header Options

ER General
2 Foreground Phato

Background

| Background

,__| [lare

.__| Image or Testure
lﬂ Teuture Pozition
i] Gradient

| £] Flash

B Color weight: = %o

Al Color sakuration: i o

A Elur: =

- P
|__| Transparency: - %
@ Blend mode; | Softlight - |
ﬂ Image Formak: | JPEG - |
] pEG quality: - 95 =] %
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The background parameters can be manually adjusted in the second tab of the "Header Options" dialog.

Define the Basic Settings of the Header Background. Depending on the selected image, some background

options may be disabled.

K

Color Weight

sl

Color Saturation

A
Blur

=

Blend Mode
(Enabled only for
‘Abstract’

backgrounds)

B
Image Format and
JPEG Quality

Background

Set the amount of the Base Color applied to the header image. The Base Color for
the header is selected under Background - Effects - Color. Supported values are
from 0% to 100%.

Specify the Base Color Intensity. The values range from 0 (completely desaturated,

grey) to 100% (completely saturated, full color intensity).

Supported values are from 0% to 100%.

Set the blur radius ranging from 0 to 30 pixels. The Blur effect averages all pixels

within the specified radius; the larger radius leads to more blurring.

Set how the header image is blended with the header color. This option is enabled

only for the 'Abstract' background images.
Supported values are:

Softlight — Lightens or darkens the bottom layer colors depending on the colors of

the Header Image.

Overlay — Blends two layers preserving the opacity, lightness and darkness of the

bottom layer.

JPEG Format supports JPEG and PNG formats.

JPEG Quality sets a quality level for JPEG compression. The range goes from 0 to
100%. Better image quality results in larger file size so drag the slider left or right to

select an appropriate trade-off between file size and image quality.
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This group provides the ability to add a photo that you can use to complement your Header. You have the
ability to choose a Foreground Photo from a variety of professional photos with many different types of

subjects. You can also insert your own photo.

V| Preview oK Cancel 100%

Foreground Photo

o Use this option to select a professional photo from a gallery grouped by subject:
Business, Communication, Teens, Music, Education, Travel etc.

Gallery
i Use this option to move the foreground object within the Header. To move the object
within the Header, select the photo with the mouse and then drag and drop the photo
Position within the header box.
When you add a foreground photo to the header, the photo is resized to fit within the
area of the header. You can resize the image using the slider bar to the right of the
header box, or if you select the “100%” button, the image will be resized to its original
dimensions.
P Use this option to insert custom foreground images from a file.
From File....
Wy Use this option to add special effects to the foreground photo. The available effects

(recolor, glow and flip) help to blend the object with the background. Recolor leaves
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Effects the original color or converts the object to grayscale. Glow softens the contrast

between the color of the object and the background color. Flip creates a mirror
reflection of the object.

The Foreground Photo options may be manually adjusted on the second tab of the "Header Options" dialog.

Header Options

& Image or Texture
ﬂ Texrture Position
W Gradient

[ £] Flash

Glow Size

H
Glow Opacity

ED) General Foreground Photo
|| Fareground Phata }

= Background Glow size: —_——— 20 % e
| Glare 8 Glow opacity: o 30~ e

Foreground Photo

The Glow Size stretches from the edges of the foreground object. The effect
is most visible on a dark background.

The Opacity option specifies the Glow intensity. Supported values: 0% (fully
transparent, invisible) — 100% (solid, opaque glow).
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Flash animations add interactivity to web pages. A little Flash enriches the web experience by enhancing

the Header of your page. Transparent Flash is light and unobtrusive; it produces an extraordinary Web 2.0

effect.
Flash
[#] | Use this option to select a Flash video from a gallery of videos, arranged into
groups: Special and Nature. You can also insert a custom Flash file or disable
Gallery Flash by selecting Without Flash.
i Use this option to: Resize the Header area to the size of your Flash video, resize
the Flash video area to the size of your Header area, or use the original Flash
Position video size. You can also regulate the Flash size with the slider located at the right
side of the dialog box.
G Custom .swf files may be inserted to the Header.
From File...
a These advanced options give more control over the Flash animation.
Options...

Advanced Options help to manage play mode, visual mode, speed, and quality of Flash videos. You can

also use custom parameters to manually modify the Flash video.
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Header Options x
G ereral Flash
[ Foreground Phota \
Auko-play: i -
4 Background Lo-piay | &3 |
@ Gilare 0 Repeat: | Yes - |
D Image or Texture
#] Testure Position H Mode: | Transparent - |
Gradient -
i il D Transparency: S 7000 %
[ £] Flash
| speed: i 1m0 5| e
Quality: High ,|
@ Parameters:

Some properties may be disabled depending on Flash realization.
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Flash
Select “yes” to have the image played automatically and “no” to enable another
Auto-play
play mode
0] Select “yes” to loop the Flash or “no” to let it play once
Repeat
Select one of three modes: Transparent, Opaque or Window. In Transparent
I=H mode, the background of the HTML page shows through all transparent portions
of the movie. This option can slow animation performance. In Opaque mode, the
Mode movie hides everything on the page behind it. In Window mode, the movie plays
in its own rectangular window on a web page
] Specify the transparency of the Flash movie from 0 to 100%
Transparency
] Specify the speed of the Flash movie with a slider from 50 to 150%
Speed
jZ] Select the quality type: best, high, medium, low
Quality
F& Enter custom parameters to modify how the Flash file is played.
Parameters

Headline Headline

4

B >

Slogan  Slogan bext

Title
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This command group provides the ability to change the Headline Text and the Slogan Text of your design.

Also you can specify the necessary Font Options: Color, Font Family, Font Style, and Font Size.

-

=]

Font

é. Color ¥
' Font Family L4

Al Size ¥
£ Style 3

Font Options...

Clicking the “Font Options...” button opens the Header Logo Name/Slogan dialog where you can adjust the
Font Settings such as the Font Family, Font Style, Font Size (in pixels), Effects, and Character Spacing.

The list of fonts you see in Artisteer are based on the installed fonts for your system. Artisteer does not
support embedded fonts so you should pick fonts that are most likely to be on a wide range of systems.
Web-safe fonts are an industry recognized set of fonts that are most commonly available on most computer

systems. You can find a list of ‘web-safe fonts’ from many sources on the web.
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Header - Logo MNarne

Font
Font Family Font Style Font Size [px)
+Headings Baold 26

Arial [Headings] a | [[Default Style] 14 -
Arial [Content] | |Reqular 16

Al Italic: 18

Arial Black Eold 20

Comic 5ans M5 Eold Italic 22

Courier Mew 24

Georgia i 2B it
Effects

A [ Underline Aa [E] Small Caps

A [ Overline aa [H] Al Caps

# [ Stikeout
Character Spacing
Font Preview

AaBbYyGgLIJj

page

This command group provides the ability to change the Title Style settings to complete your Title. The Title
Style group includes the following functions: position, size, align.

Title Style

i Select the text box with the mouse and simply drag the Title to the desired place.

Position

—

I~ Choose the appropriate font size from the suggested thumbnails.

Size

—

Align

= Choose the appropriate alignment from the suggested thumbnails.
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The Menu tab is used to control the position and design of the horizontal menu. The tab also includes tools
for managing the design of menu items and subitems. As always, you select the appropriate level of
customization using either the fully automated suggested design, or manually, using the customization
options on the Ribbon bar. Artisteer supports three of the most popular Web 2.0 menu styles: classical (with
separators), tabbed and buttons. You can regulate the margins and text alignment as well as add effects
such as texture, gradient, and transparency.

Menu

£ = Length ~ ) : = E == SrFil- === 1 Fill~ —— SaFin-
; * Margin ~ [ e . Passive |« * i i L Barder~
Suggest Menu Position Styling Colorin Menu Bar Item Subitem
o > g Colering > - A Text~ - A Text-

Ideas Layout Menu Styles ] Menu Bar ] Item ] Subitem (F]

The Menu Layout helps to find the appropriate position, length and top margin.

Note: Artisteer supports only one horizontal menu, and adding more menu items than can fit across the
page will have unpredictable results.

Layout

This option suggests two position types: Inside Sheet and Outside Sheet. The
menu located inside the Sheet may be placed above and below the Header.

Here you can also disable the horizontal menu.

Position
Select Sheet Width or Page Width to make the menu fit the sheet or the page.
Length
= Use this option to set the distance from the top element. Positive top margin

values range from 0 to 50 px; you can also select a negative margin of either —20
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Margin or -10 px value.

The advanced options include Horizontal and Vertical Margin settings. Use the advanced options to
regulate the distance between the menu items (Item Distance), the range of Top Margin values, as well as

the Top Outline feature, which enables or disables the rounded menu corners of the menu.

Note that the Layout advanced options are located in the first selection of the Menu Options dialog box.
You can also open these options by selecting the Custom Values ™ icon in the Menu Styles command
group on the Ribbon bar.

- -

Menu Options X
= Layout LayoLit
= Menu Bar
. Harizonkal Margin: (& b3
':'@ Merw Bar Testure Pozition c - R
= -
@ Menu Bar Texture Wertical Margin: = p
F= Itemn
I:IIEI Itern T exture Item Diskance: = P
[T — - —
Subitem [+ Top Margin: - 20 I px

[t]-l Top Outline: Yes -

Change the overall style of the menu buttons including the shape, coloring, borders and spacing between

the items. You can choose a menu from the gallery, or compose a custom menu using the Styling options.

Menu Styles

The gallery contains ready-made menus for fast and easy styling.

Passive
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Gallery
——) Use this option to change elements of the menu style such as shape, margin,
alignment, distance, separator, radius, and shadow. It contains more elements than
settings.
Styling
= Use this option to select a color scheme for the menu bar, and the colors of the
- active and passive menu items.
Coloring

Refine the horizontal menu bar further by choosing the texture, gradient, border color/weight, as well as the

fill/transparency effect.

= aFil-

L+* Border ~
Menu Bar

-

Menu Bar P

Menu Bar

— Use this option to select a texture and/or gradient for the menu bar background. You
can choose one of the suggested textures or insert a custom texture. You may

access the advanced gradient settings in the Menu Options dialog by selecting

Menu Bar ) ) . ) ) ) .
Gradient Options in the gradient list, or by selecting the Custom Values = icon.
Texture options are also located within the Menu Bar Texture and Menu Bar Texture
Position tabs of the Menu Options dialog.
L) This option provides a choice of colors you can select from for the menu bar
background, as well as transparency settings. You can select a color theme, or pick a
Fill color from the custom palette, or add your own color with More Colors. Transparency

settings range from 0 to 100% and can be disabled.
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L* Use this option to control the border at the bottom of the menu bar. This option

controls the border color, weight and width. Border width ranges from 1 to 4 px. For

Border advanced adjustments select More Borders (see below). This option may be

disabled depending on the styling (shape) you have selected for the menu bar.

The “Menu Options” dialog allows you to adjust Gradient, Border and Transparency. To open this dialog,

y o«

click the “Gradient Options...”,

appropriate list, or select the Custom Values ™= icon.

Menu Options

= Layout

= Menu Bar

_lﬁl Menu Bar Texture Position
5 Menu Bar Texture

= Item

£ Itemn Testure

= Subitemn

Menu Bar

Border width:

d aradient contrast:

_| Transparency:

Texture Options”, “Transparency Options” or “More Borders...” button in the

o

o

=

The advance texture settings come in two tabs. The “Menu Bar Texture” tab regulates color effects while

“Menu Bar Texture Position” tab controls the manner of texture placement. Some options may be disabled

depending on the existing menu style.
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page

Menu Options

= Layout
= tenu Bar

eru Bar Texture Position

tenu Bar Testure

= Item
[tern Texture
&~ Subitem

Menu Bar Texture
L@ Blend mode:

@ Transparency':
Rl| Color weight:

& Color sakturation:

Oreerlay

=

|ﬁ—.l Conkrask:

@ Smarkt Invert:

Mo

The Menu Bar Texture tab contains adjustment options such as Blend Mode, Transparency, Color weight,

Color saturation, Contrast, and Smart Invert. The options you can set for the Menu Bar Texture are similar

to the same options you can select for the page background. You can find a description of these options in

the Background section of this guide.

=

Menu Optons

' Layout

" Menu Bar

benu Bar Testure Pozition

Meru Bar Texture
F= Item

[tern Texture
' Subitem

Menw Bar Texture Position
ey Flips

Sk Rotate:

o Scale:

|f| Texture repeak:

I-—l -
— Position:

| MNone

4

| Mone

4

6

(Fill

4

| Top Left

4

The options you can set for the Menu Bar Texture Position are similar to the same options you can select

for the page background. You can find a description of these options in the Background section of this

guide.

artisteer.com | page 83



Artisteer

Web Design Revolution

9.4. Item

Ribbon Options

T

Item

L3

Within the item area on the ribbon you can:

e Set the Size, Radius, Texture and Gradient values for the menu Items.

e Adjust Border weight and color;

e Change color and text parameters.

Advanced Options

Sy Fill -
L Border ~
é. Text =
Item

]

34

page

If the default settings don't meet your needs, use the "Menu Options" dialog to adjust the option settings.

Menu Ophions

= Layout

= Menu Bar

% Mer Bar Texture Pozition
% ke Bar Texture

1%' Item

% [tem Testure
= Subitern

Item

=1 Horizontal padding:
I vertical padding:
Radius:

. Border width:

w Gradient contrast:

=
=

=
=

o
=

=
=

x

Transparency

| Passive:

E] Active:
[:] Howered:

O © O T GBT

—
LR
=]
-

o
=

o
=

o
=
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ltem

—

| Specify the horizontal distance between the Item Text and Item Borders.
Horizontal padding  Supported values: 0 — 50 pixels.
= Specify the top and bottom padding of the Menu Items. Supported values: 0 —
Vertical padding 50 pixels.

A Specify the Corner Radius (shape) of the Menu Item. Supported values: O -
Radius 100%.
D Specify the Width of the Menu Item Borders. Supported values: 0 — 5 pixels.
Border width

This option is disabled when the Menu Items have no borders.

Specify the contrast between the starting and ending colors in the item

gradient. Supported values: -100 (solid color) to 100% (the most contrast
n gradient).

Gradient contrast ) ] ]
To enable select any Gradient from the Menu - Item - Item - Gradient list.

Enhance your design with transparency effect.
K Passive — state of the item when not selected.
Transparency Active — state of the item when selected.

Hovered — state of the item when the mouse cursor is hovering over the item.

To adjust the texture of menu items, open the Item Texture section/tab in the Advanced Options dialog box.
The Item Texture options you select are the same options you can select for the page background. For a

description of these options, refer to the Background section of this guide.
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9.5. Subitem

g b Fill -
L Border~

Subitem
- A Text-

Subitem P

This section provides the ability to control the appearance of items in the submenus that appear when you

select a menu from the menu bar.

Ribbon Options
You can adjust the following options:

e Enable or disable Multi-level menu (Levels option)

e Add a Gradient to the subitem background (Gradient option)
e Change the Size of subitem boxes (Size option)

e Fill subitem background with color

e Change the size of the subitem border

e Apply a style to the subitem Text

Advanced Options

If the default settings don't meet your needs, use the "Menu Options" dialog to adjust the option settings.

Menu Options *
B2 Layout Subitern
= Menu Bar — <
% kenu Bar Texture Pozition I Width 160 . | P
% kenu Bar Testure I Height: - P
= Item
B2 ltem Testure ) Border width: —i P
' Subiter bl Gradient contrast: =] S
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Please note: The options are disabled if “No Submenus” is selected in the Subitem list > Level. Also please

note that the Gradient contrast option is disabled if “No gradient” is selected in the Subitem list > Gradient.

Subitem

[

= Specify the horizontal distance in the Subitem drop-down list, in pixels.

Horizontal padding  Supported values: 0 — 50 pixels.

= Specify the top and bottom padding of the Menu Subitems. Supported values:
Vertical padding 0 — 50 pixels.
[:] Specify the width of the Subitem Borders. Supported values: 0 — 5 pixels.
Border width

Specify the contrast between the starting and ending colors in the Subitem

Gradient. Supported values: -100 (solid color) to 100% (the most contrast

-

. radient).
Gradient contrast 9 )

This option is disabled if you have not selected a gradient for the subitem.
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In the Ribbon bar area for Articles you can find options to style the text and control the space around the
text, as well as options to brighten up your articles with styled images, quotes, and metadata. On the
Ribbon bar there are several command groups: Preview Image, Shape, Text Formatting, Other Elements,
Header and Footer.

Articles

E‘ E] -;Ev §|4_- Ig- 33 - ﬂ Headings = E Bullets - Date = = Category -
- B 2 Hyperlink ~ 5L Image ~ 2 Author - P Tags~
Suggest Styling I ——— Header ) Footer
Arficle Design - — €€ Quote - @Table - - [hEditr . &5 Comments -
Ideas Preview Image Shape Text Formatting Other Elements [P Header [P Footer F]

In this command group, you can choose the Article Content Shape (Blockless or in-Block), and using the
Styling button, change the following style options:

e Content e Shape e Effects (when ‘shape’ is
e Margin o Fill active)
e Text e Border e Shadow (shadow and glow)
e Padding e Transparency
e Radius

‘In-Block’ means the article appears in a block area of the display with a border. The Shape button can be
used to control features listed above to change the appearance of the block. ‘Blockless’ means there is no
block area. You can select the margins around the article and the text spacing (padding) around the text in
the article, but border features and block features are not available. You choose the type of block by
selecting the Styling button->Shape->Content Shape from the Ribbon bar.

Please note, the Preview Image in the article is not part of your template. You supply pictures as part of the

content you define for the article in your CMS. In Artisteer, you decide if images you add later will have a

artisteer.com | page 88



Web Design Revolution page

border, and what the spacing should be between the images and text. The image you see in the Preview is
just a placeholder for images you supply later. Artisteer provides this as a visual aid so you can see how
your Image effects, such as border, will appear with the text of your article.

If the default settings do not meet your requirements, you can use the "Articles Options" dialog to customize
the settings. To open the Article Options dialog, click on the “More..” button, for example “More

Paddings...”, below any list, or select the Custom Values ™ icon.

Article Dptions x
I Shape | Shape
==| Metadata 1 _ . -
%) Shadow T (S 02| px
:= Bullets E Padding: - 10 2| px
€€ Quote
| radius: = 02| px
D Border width: = 12| px
| Transparency: ¥ a0 T %
Shape
H Specify the Margin of the Article content in pixels. Supported values are: 0 —
Margin 50 pixels. The margin is the space around each Article.
'E Specify the Padding of the Article text in pixels. Supported values: 0 — 50
Padding pixels. The text padding is the space around the text within each Article.
J Specify the Corner Radius (shape) of the in-block content in pixels.
Radius Supported values: 0 to 40 pixels.
()] Specify the Border Width of the in-block content in pixels. Supported values:
Border 0 to 10 pixels. O corresponds to “Without Border”.

Width(Available if
In-Block Shape

is used)
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K Set the transparency of the content block. The supported values are from
0% to 100% where 0% means "without transparency".
Transparency
(Available if

In-Block Shape

is used)

Clicking on the “More Shadows...” button in the styling—>Shadow list opens the “Article Options” dialog

where you can adjust the shadow options.

Article Options x
Y Shape Shadoy
==| Metadata :
. Size: —— | 33
b Shadow e - &
EE Bu”EtS !I C'Flal:it}": {:} 30 : e
€€ Quote
S Distance: - pix
= Angle: i 45 C| @

Please note: The Shadow Options are available only for the In-Block Shape.

Shadow
i= Specify the Shadow Size of the Article block in pixels. Supported values: 0 — 20
Size pixels.
L] Specify the Shadow Opacity of the Article Block. Supported values are: 0 to
Opacity 100%.
= Specify the Offset Distance of the shadow in pixels. Supported values: 0 — 20
Distance pixels, where 0 indicates no offset.
e Specify the Angle at which the shadow is dropped from the Article Block.
Angle Supported values: -180° to 180 °.
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10.2. Text Formatting

Ribbon Options
This command group allows you to change the Text format options like:

e Margin Left

e Margin Right

e Line Spacing

e Character Spacing
e Font Options

e Align

Size 3
Style 3
[ Font Options... [

I Font Family »
Al
i

Advanced Options

Clicking on the “Font Options...” button opens the Article Content-Text option dialog box where you can

adjust the following Font Settings.

e Font Family

e Font Style

e Font Size (in pixels)
o Effects

e Character Spacing
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You can also access the advanced options in the Article Content-Text dialog box,

Options...” in any of the Text Formatting lists.

Article Content - Text

Fort | Paragraph

Font Family Font Style Font Size [px]
+Content Regular 12

[Default Font) - [Default Style] [Default Size] -
Arial [Headings) | |Regular a

Avial [Content] Italic 9 EI
Avrial Bold 10

Avrial Black, Bold Italic 11

Comic 5ans M5 12

Courier Mew i1 13 b1

Effects

A [E] Underline
A [E] Overline
# [E] Stikeout

Character Spacing

Spacing: EH

A [B] Small Caps
aa [H] Al Caps

Marmal

I
o
L=

Defauld =

Font Preview

AaBbYyGalll

V| Preview

Ok | | Cancel

Note: You can also modify the Paragraph settings including:

Alignment
Indentation

Spacing

Article Comtent - Text

Farnt Faragraph

Aligrment: =

Indentation:

Left Side: =IE
Right Side: =]«

Indent Firsk Line:

P *= |Default = | px

Spacing:
Before: %
After: =
“whord: g
Preview

Line Spacing:

P 1=

Foza graph Paza gragh Faza graph Paxa graph Baza graph Faza giaph Paza goaphPaza gragl Paga gapl Paza gra gl Paza grapls
Pz gaph Paza aph Paza

Pazn gaph Paza sl Paza praph Pazs gaph Pazs gaph Paza a il Pz aph Pazs gaph Pazs gaph Pazs gaph Pazs gagh

Fazagaph

ke

Pz guaph Paza oapl Paza grapd Pazs goaph Pazs graph Pazs gua plFass goagh

V| Previews

Ok | | Cancel

by selecting “More

page
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ﬁHeadiﬂgs' s— Bullets =
52 Hyperlink ~ 5L Image -
€€ Quote~  Hd Table-~

Other Elements la

This section provides the ability to control the look of the following article elements:

e Headings

e Hyperlink
e Quote

e Bullets

e Image

e Table

You can change the font options, quote style, bullets image, table border settings or image border settings

to make your Article more unique.

The Headings elements refer to the HTML headings in your article text. Whenever you add some article
text, you have the option of including a header in your content using one of the HTML styles: H1, H2, etc.
Artisteer allows you to select the default color, font, size, font style and alignment associated with each of

these heading styles.

The Bullets elements refer to bulleted lists that you may include in your article content. Like the other
elements, you can define the default color, font, size, font style, and alignment of any list you insert into your
content. You can also choose an Image for the ‘bullet’ that appears next to your list text. You can select
from a variety of ready-made images, or insert your own custom image. You can also change the color of
the bullet.
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[3= Bullets = |

Bullets

:=  Image ¥ | Color

Font . Color *
A color * | Mo Bullets -

T Font Family 4 I l

Al Size 3
£ Style ¥ | Simple Arrow
B Font Options... b . ,

|_?-‘ Insert Bullet from File...

| Bullet Options...

Quote elements refer to quotations you may add to your article content. Like the other text elements, you
can select the default color, font, size, font styling, and alignment of your quoted text. Apart from standard
text settings, the Quote settings let you define a distance around the quotation (padding), put the quote
inside a filled block with borders, change the color of the block the quote appears in, and/or select a quote
image. You can choose an Image from a variety of ready-made images, or insert your own custom image.

You can also change the color of the Quote image.

Table Border elements refer to HTML tables that you may include in your article content. You can select

the default border width, border style, and border color for tables you insert in your article content.

Hyperlink elements refer to HTML hyperlinks that you include in your article content. Like other elements,
you can select the color, font, size, and font styling applied to the hyperlink text. You can also decide if the
link should appear with an underline or not. You can define these features for each of the states of the
hyperlink. Link —normal, unselected appearance on the page. Visited Link — appearance of the link after
the link has been selected once by someone. Hovered Link — appearance of the link when the cursor is

moved over the link on the page.

Clicking on the “Font Options...” button in any of the submenus (Headings, Hyperlink, and Quote) will open
the Article Content Option dialog window where you can adjust the Font, and Paragraph formatting (for

Headings and Quote) settings.
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Article Comtent - List X
Font Family Font Style Font Size [px]
+Carntent [Default Style) 12
Avial [Headings) i | | [Default Style] 8 -
Auial [Content] —| |Regular k|
Aial talic: 10 E|
Avial Black Bold 11
Caomic Sang MS Bold [talic 12
Courier Mew 13
Georgia i1 14 i1
Effects

A [B] Underline Aa [B] Small Caps
A [B] Overline aa [B] Al Caps
A [B] Strikeout
Character Spacing
Font Preview
AaBbYyGgLLj
| Preview (1].9 | | Cancel

The list of fonts you see in Artisteer are based on the installed fonts for your system. Artisteer does not
support embedded fonts so you should pick fonts that are most likely to be on a wide range of systems.
Web-safe fonts are an industry recognized set of fonts that are most commonly available on most computer

systems. You can find a list of ‘web-safe fonts’ from many sources on the web.

Clicking on the “Bullet Options...” button in the Bullets>Image submenu will open the Article Option Dialog
where you can change the Offset and Recoloring option of the Bullets. These options are disabled if you
have not selected a bullet image.

I3

Article Options n
") Shape Eullets

_:l hdetadata - ]

B Shadow = Offset: i o
Ll % Recoloring: Yes T|

€€ Quote
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Bullets

-—

= Specify the indent between the Bullet and the List Text. Supported values: 0 —
Offset 20 pixels.

Specify whether the bullets should be re-colored.

B Normally the bullets are displayed in a default color. You can change the
Recoloring color of the bullet image with Bullets=>Image—> Color. If this option is set to
No, the bullet image appears in the default color, otherwise, the bullet image

appears in the color you selected.

Clicking on the Custom Values ™ icon will open the Article Options Dialog box where you can change the
Icon Offset and Padding options of the Quote.

Article Options x
Y Shape Quote
=| Metadata
“ , —
5 Shadow Icon Offsetk; = i
:= Bullets 15 Padding: = P
€€ Quote
Quote
i Specify the indent between the quote image and the quote text. Supported
values: 0 — 20 pixels.
Offset
'@ Specify the Padding of the Quote text in pixels. Supported values: 0 — 50
Padding pixels.

This is the space around the text within the quote block.
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You can use these options to customize the Article Header and Article Footer.

Date = B Category =
2, author - JT Tags
Header Footer
- D} Edit - + = Comments -
Header Footer

The Header>Header Layout, and Footer->Footer Layout option lets you select whether or not the
header/footer text, or the metadata (e.g. date, author, etc.) appears in a block area. If you include a block

area, you can control the border and color of the block. Without a block, these options are not available.

These options also allow you to change the appearance of text in the header/footer, and the appearance of
links (based on their state). You can also define an image that appears with the header as well as the color

of the image.

The header and footer also include metadata (e.g. Date, and Category). You can elect to include, or
exclude certain metadata (e.g. Show Date), and you can select an image that appears alongside each

metadata item.

|. Drate ~
Display
o | Show Date
Color

. Icon Color L

Mo Icon -

[ ]

Classic

st
—

J Insert Icon from File...
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Advanced Options

Article Options X
L Shape Metadata
|_E| Metadata Header
Zh Shadow <
- E] Transparency: - I W
*— Bulletz
€ Quate Fooker
E] Transparency: = %o

The advanced options for metadata allow you to control the transparency in the filled metadata blocks. The
values range from 0 to 100%, 100% standing for the complete transparency. This option is not available if
you have selected a Layout that does not include a block.
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Sidebar is the column on your page with additional content. The appearance of the sidebar can be
changed by using either ‘styled blocks’ or ‘plain blocks’ for the sidebar styling. You select the type using
the Sidebar Styling button—> Styling on the Ribbon bar. Blocks are the individual components that make up
the content of the Sidebar. Things located in the blocks include links, bookmarks, search fields, and the
overall postings of the page. Apart from blocks, the Sidebar may also contain a Vertical Menu, which is an

important element of navigation (see the section Vertical Menu, below).

The Ribbon bar options for Sidebar may be divided into three main groups: Sidebar Layout/Styling, Block
Styles, and Block Content.

Sidebar

\E} [=] suggest Blocks e

7 :| Suggest Vertical Menu
Suggest Sidebar Sidebar Styling Layout Suggest Blocks

HE- Ee- IE- B -
=| Header ~

Stylin A-e28.1=-F-
tyv ¢ | Content ~ L= ;-LI

Ideas Sidebar "] Block Ideas Elock Styles [F] Block Content

With the help of the Sidebar Styling button you may enable the styling or leave the sidebar unstyled. When

Styling is enabled you can add and/or modify the following design elements:

e Color
e Transparency

e Glare (Glares may be also inserted from custom files)

The Layout option defines the number and position of columns on the page. You can select a layout with
one, two or three columns, being located at the right, left or both sides of the main content. The number of
columns determines the number of sidebars on your page (counting your article column as one column).
So, one column means ‘no sidebar’, two columns means one sidebar, and three means two sidebars. Note:
you may notice that some of the sidebar options are available even though ‘no sidebar’ is visible. Your

selections are applied to the sidebar, but the changes only become visible after you change the layout.

artisteer.com | page 99



Web Design Revolution page

Advanced Options

There are advanced settings for columns, which you may enter by selecting “Width Options...” in the end of

the Layout list:

Layout Options

| 2] Columns Colurnns

— Top Margin: o P

CH Top Outline: Mo -

=1 Colurnn 1 width: S
Column 2 width: =]
Column 3 width: =]

Specify the Top margin (0 — 200 px), Top Outline (enable/disable) and Column Width (10 — 500px).

The options in this command group start with a Gallery, where you can choose one of the suggested

‘ :

Block Styles

layouts for blocks.

The visual menu lets you easily decide if your blocks have a header, if your blocks, block content and/or
block headers have a border or background, and the type of border, and background for each. As you
move the cursor over each choice, your Sidebar Preview will show you how the sidebar will appear if you
select that choice. Note, the block style you select determines which style options are available on the

Ribbon bar, menus, and option dialogs.
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11.2.1. Styling

Ribbon Options

The Styling option provides the ability to change block spacing, alter the distance between blocks, or make

the blocks more rounded by changing the radius value.

@ Background - SE- Fer 1=+ 33 -
|5| Header =

Stylin A-E3- = -
ty, - ECUﬂteﬂtv | — — L= % |
{[2J] Radius » | Radius -
' Block Spacing  *
P g Mo Radius
f,: Distance r
[ 10 pixels
f 15 pixels
b
i+  More Radiuses...

Advanced Options

Clicking on the “More....” buttons in Styling lists will open the Block Option dialog where you can adjust the

layout options.
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Block Options

=] Lapout
| Background
2k Shadow

| Header

i= Content

lzan

-
*— Bulletz

J

Radius

Block spacing

f

Distance

5 Header Texture Position

i Header Texture

page
x
Layvout
| radius: B = E— m P
"' Black spacing: - 10 7| px

E Distance: —i— pix

Layout

Specify the Radius of Block Corners (shape). Supported values: 0 to 40
pixels. This option is not available if you have selected a block style that has
no border.

Specify the Spacing around blocks in pixels. Supported values: 0 — 40 pixels.

Specify the vertical distance between the Header and Body sections of the
Block. This option is not available if you have selected a block style without

borders around one or more sidebar items in a sidebar with a border.

The Background option is active if the block style selected includes a border around the entire sidebar. You

can change the inner padding, background color, border and transparency of the blocks, as well as add
different Effects to your blocks.
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E Background - =

Layout

- __Elq-v Igv %_‘av

TE Inner Padding » | Padding -
Shape
S Fil b E 10 pixels
g Border 3
T 3
E] ransparency E 15 pixels
Effects
— v
D Texture 4
| Mare Paddings...
W Gradient >
&  shadow C
Advanced Options
Clicking on the “More...... ” buttons will open a Block options dialog:
Block Options X
E Layout Background
E B ackground
Padding: —i 7
B Shadow 5 Padding P
B Header . Border width: —= pie
@ Header Texrture Position
; , o
@ Header Texture i Gradient contrast: = .
—
& Content || Transparency: = L
lzon
% Texture
+— Bulletz
lE Transparency = e 'S
@ Blend mode: | Softlight -.-|
Rl Color weight: = %
wll Colar saturation: = 0 o %
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i)
Padding

a

Border width

o~

Gradient contrast

¥

Transparency

&

Blend mode

K

Color Weight

il
Color Saturation

page

Background

Specify the space between the outer borders of the Block and the content
area within the Block. Supported values: 0 — 50 pixels. This option is not
available if you have not selected a block style.

Specify the Block Border width. Supported values: O — 10 pixels. This option
is not available if you have not selected a block style.

Specify the luminance difference between the starting and ending colors of the
gradient. Supported values: -100 (solid color) to 100% (the most contrast
gradient).

This option is not available if you have not selected a gradient (Blocks >
Block Styles - Background - Gradient).

Specify the Transparency of the Background Texture. Supported values: 0
(fully opaque) — 100% (fully invisible).

Specify how the Texture blends with the underlying layer of the block.
Options:
- Normal - No effect on the underlying layers.

- Soft Light - Lightens or darkens the image depending on the color of
the Texture Image.

- Overlay - Blends the layers together by changing the opacity, darkness,
and lightness of the Texture Image.
Set the amount of the Base Color applied to the header image. The Base
Color for the header is selected under Background > Effects - Color.

Supported values are from 0% to 100%.

Specify the Base Color Intensity. The values range from 0 (completely
desaturated, grey) to 100% (completely saturated, full color intensity).
Supported values are from 0% to 100%.
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If you select a template with a shadow effect, the Shadow option will provide the ability to change size,

angle and opacity of the block shadow as well as indicate the distance between the shadow and the block

borders.

Just click on the “More Shadow...” button in the Background - Effects - Shadow list.

Block Optons

[=] Layout Shadowy
= | Background
. - 3 -
2 Shadow 22 = - P
| Header 5 opacity: & 40 | =%
= .
i Header Texture Position
[ ) —
o Header Testure Distance: A= P
i Content = angle: - 45 | =
[con
2= Bullets

Specify the shadow options. The options are disabled for no-block styles selected in the "Block Styles" list.

1=
Size
!|
Opacity
m
Distance
=

Angle

Shadow

Specify the Shadow size. Supported values: 0 — 20 pixels.
Specify the Shadow Opacity. Supported values: 0 (fully transparent) — 100%
(fully opaque).

Specify the Shadow Offset in pixels. Supported values: 0 — 20 pixels.

Specify the Shadow Angle starting from the edges of the block. Supported
values: -180° to 180°.
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Using the Ribbon options allows you to adjust the font, icon, and shape of the Block Headers. You can also
enhance the design by adding a texture and a gradient, or by inserting a custom texture or a custom icon
image.

The Ribbon options for content are similar to those for the Header. You can adjust the design of the content

shape and add visual effects. The unique feature of Block Content is control over text padding.

|.E|Header*|

Content )

A Tet »
Icon L4

Shape

B Fil g

E_? Border r

.| Transparengy »

Effects
& Texture 3
@l Gradient 3

Clicking on the “Texture Options...” or “Gradient Options...” in the appropriate list will open the Block Option
dialog where you can adjust the settings.
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[E] Layout Header
= Background )
) Shadow D Eaeer ndn o [
| Header I vertical padding: -
padading: = px
‘:Q Header Texture Pozition
= Gradient
Header Texture
\E&] —
g]Eu:untent .ﬂ radient conkrast: = e,
leon | Transparency: & o
2= Bullets

Header

]
=

Header Texture

Position

—
=

Header Texture

-

Content

Icon

-

- —

Bullets

Block Header and Content

Specify the value of the Width of the Block Header Border (0 — 10 px), the
Vertical Padding (0 -25 px), the Gradient Contrast (-100 — 100 %) and
Transparency (0 — 100%).

This section contains the following settings: Flip (vertical/horizontal), Rotate
(CW 90/CCW 90), Scale (10 — 130%), Texture Repeat

(filyhorizontally/vertically), and Position (top left / center left/bottom left).

Within this section you can adjust the Transparency (0-100%), Blend Mode
(overlay, softlight, normal), Color Weight, Color Saturation, Contrast, and

Smart Invert.

The advanced options for Block Content include Padding (0 — 50 px), Border
Width (0 -10 px), Gradient Contrast (-100 (solid color) to 100%), Blend Mode,
Transparency (0 (fully opaque) to 100% (fully transparent)), Color Weight,
Color Saturation.

Specify the Offset value (0-20 px).

The available options are: Offset (0-20 px) and Recoloring.
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11.3. Block Content

A==
Elock Content

—hl%v Eld—v Igv %_’a -

Ribbon Options
Within the Ribbon you can apply the following font options:

e Margin Left

e Margin Right

e Line Spacing

e Character Spacing
e Font Options

e Link Options

e Bullets

e Image Options

The Font settings allow you to modify the font color, font family, font size, font style, and text alignment:
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You can also use the standard font settings to design how hyperlinks appear and create variants for visited
and hovered links:

B3 ::vl

&2 | Link 3
59 Visitedlink  »
=W Hoveredlink

The Image settings allow you to adjust the margin around the image, and design the appearance of the
image border.

=N
Image Border

== FBorder Width »

Zz | Border Style b

-

|:| Border Color
r[: Margin

-

Advanced Options

Clicking on the “Font Options...” button will open the Article Content-Text options dialog where you can
adjust such Font Settings as:

e Font Family

e Font Style

e Font Size (in pixels)
e Effects

e Character Spacing
And the Paragraph settings like:

e Alignment
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e Indentation

e Spacing

Fant Family

Fart Style Font Size [px]

| |F|egular | 12
Arial Headinis - DefauItStiIe
=
Arial 1
Arial Black
Comic Sans M5
Courier Mews
Georgia

| +Cortent

Effects

A [E] Underline
A [F] Overline
A [H] Strikeout

aa [B] Small Caps
a4 [B] All Caps

Character Spacing

T

Fant Preview

AaBbYyGgLLj
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12. Vertical Menu

Ribbon Options

Both Vertical and Horizontal Menus are the elements of navigation and design. Vertical Menus are usually
located at the top of the right, or left sidebar (column). Designing Vertical Menus is a creative task. Artisteer
provides many settings, which are arranged on the Ribbon bar in four groups: Layout and Styles, Menu Bar,

Item, and Subitem.

Vertical Menu
B -jl Background % E. SFin- E He Srrn-
E —— S > |5 Header ~ == %o L Border~ —J ‘e L Border~
Suggest Pasition = — ﬁ Menu Menu Bar —; Item Coloring Subitem Coloring
Vertical Menu - = Subitern » Subitem [ESTe— Block ~ - &) content - - - ATed- - - ATed-
Ideas | Layout | Styles | Menu Bar [F] | Item I | Subitem n |

12.1. Layout and Styles

Ribbon Options

The options of this section provide the ability to select the position of the Vertical Menu in the general layout
of the page as well as to select one of the most popular vertical menu styles. Open the Position list to
choose the appropriate place for your Vertical Menu and look through the Styles gallery to find the type of

Vertical Menu you prefer.

s ]
=»  Subitem PR

Styles
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Using the Menu Bar options, you can adjust the color and shape of the Menu Bar, add such effects as

texture, gradient and shadow, and manage the design of the vertical menu Header and Content.

Vertical Menu

| == 5| Background ~
= Header ~
Menu Menu Bar
Block = . &= Content -

Menu Bar F
Menu Bar
u Contains menu block layouts. The layouts are arranged into three groups:
Simple, With header, Without Header. The layout you select determines
Menu Block which other options are available to style the menu.
= Select the appropriate Margin, Radius and/or Distance.
Menu Bar
=] Adjust the Inner Padding, Shape (color, border, transparency) and add visual
effects (texture, gradient, shadow).
Background
] Adjust the Content (text, icon), Shape (color, border, transparency) and add
visual effects (texture, gradient).
Header
) Adjust the Content (text padding), Shape (color, border, transparency) and
add visual effects (texture, gradient).
Content
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Block Options X
|:| Layout Layout
= Backaround i =
% Shadow Fadius: = 2
| Header "¢ Margin: - P
iy Header Texture ~
=) Content £ Distance: —i= =

lzan

The advanced options for Background, Header, and Content are similar to those you can specify for other
blocks in the sidebar. For a detailed description of the advanced options see the previous section on

Sidebar and Block Styles. You can access the advanced options by clicking on the Custom Values = icon.

J 5. SrFin~
— b Zﬁnrder*

Item Coloring
. - A Text-

Item s

Menu Item options let you adjust the design of the menu item’s shape (shape, distance, height, radius) and
content (icon, separator). The item options also include visual effects (texture, gradient, shadow), which
enhance the menu appearance, and you can select a Coloring scheme, that helps highlight the difference
between active, passive and hovered items in the menu. Icons and separators add zest to your design

while standard Fill, Border and Text options are for adding finishing touches.
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H.. i
L
Colori == o
oloring
N9 A Te

Sy Fill -

Ll' Border -

Shape

Ty Shape 3
r,: Distance L
I Height >
Radius .
Effects

- Texture »

[ cradient  »
By, shadow »

Content
,
i :jpnarator 3 e E
Advanced Options
Menu Options x
lham Item
%g: dzf:ture [0 Height: - 24 1| px
H Subitem F= Distance: ! 4 *| px
| Radius: e %
() Border width: — e |I| e
wal Contrast: e o
Iron Cffset: e e
Transparency
| Passive: o o
| Active: o o
| Hovered: o o
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j 2. SFin-
— be L Border~

Subitem Coloring
- - A Text-

Subitem Fa

The Ribbon bar options for Subitems are very similar to that for Iltems. There are settings for adjusting the
shape (vertical offset, height, and distance), content (icon, separator) and effects (gradient). One of the
most important design options for subitems is the way they are opened. You can adjust the dynamics of
subitems by opening Subitem 2> Levels and selecting one of the following options: “One Level” (there is
only one list of choices for this vertical menu), “Open by Click” (subitems do not appear until you click on

one of the top-level items), or “All Open” (all subitems are shown in the menu).

=

Subitem
Style
% Levels | Levels
Shape One Level
G | Vertical Offset  » Open by Click
IE Height *
All Open

f— Distance »
Effects
ml Gradient r
Content

Icon »
= Separator *
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Advanced Options

The advanced options for Subitems include settings for

- height (height of the submenu, from 16 - 50 px),

- distance (distance between subitems, from 0 - 50 px),

- top offset (distance of the subitems and the rest of the menu, from 0 — 50 px),
- border width (around selected subitem, 0 — 5 px),

- contrast (available only if you have selected a gradient), and

- icon offset (distance between the image and the subitem text).

Menu Options x
tem Subitern
[tern Texture -
= Height: — 2z -
Zh Shadow =t -] PX
E Subitem f Distance: = px
§ Top offset: = P
. Border width: = pix
bs| Conkrask: = &
Icon
Offset: = i

You can access the advanced options by clicking on the Custom Values = icon.
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13. Buttons

Ribbon Options
Use the Buttons tab to change the shape and style of Buttons on your page.

Buttons

‘%“u E_] |§|Texture* ﬁFlII Color -
= Buttan [ Buttan ] [ Button ] - |l Gradient - [@) Border~
Suggest Buttons Shape
99 2P° Q) shadow~ A Text-
Ideas | Button I

Select from a wide variety of button styles. You can choose buttons with more rounded corners, something

in between, or completely rectangular in shape.

Button [ Button ] [ Button l

The Button section allows you to change the following options:

e Shape
e Texture

e Gradient

e Shadow
e Border
e Fill Color

e Border Color

e Text
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Artisteer provides a wide variety of Button shape templates. Also, if you click on Shape—> “Shape

Options...”, Artisteer has a number of advanced options you can use to customize your buttons.

also open this dialog by selecting the Custom Values ™ icon).

Button Optons

|oE Gerneral
_ | Transparency
| Texture
b Shadows

[ —

|
Horizontal padding
I

Vertical padding

—

=

Width

r

Radius

O

Border width

=

Gradient contrast

| General
= Horizontal padding: = 10 2| px
I wertical padding: — 72| opx

widch

= width Type Auko -

M radius: = 25 2| %

[ Border width: = 1 2| px

sl Gradient contrast: = o %%
Button

Specify the horizontal distance between the Button Caption and Button

Borders. Supported values: 0 — 50 pixels.

Specify the vertical distance between the Button Caption and Button Borders.

Supported values: 0 — 50 pixels.

Specify the Width Type (auto or fixed) and/or Width Size (when fixed width
type). Width Size values range from 0 to 200 px.

Specify the Button Corners. Supported values: 0 — 100%.

Specify the Width of the Button Borders. Supported values: 0 — 10 pixels.

Specify the Contrast between the starting and ending colors in the button
gradient. Supported values: -100 (solid color) to 100% (the most contrast
gradient). This option is not available unless you have selected a button

gradient.
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If you add a Shadow Effect to your Buttons, you have the possibility to make custom changes to the

shadow effect in the Button Options dialog.

Button Options x
ok General Shadow
.| Transparency _ . -
2 Texture Size: = -
=) Shadow 2 opacity: ———————— 15 7| %
& Distance: —i P
& Angle: - 45 | =
Shadow
= Specify the Blur Size of the shadow. Supported values: 0 — 20 pixels.
Size
L] Specify the Shadow Opacity. Supported values: 0 (fully transparent) to 100%
Opacity (fully opaque).
L Specify the Shadow Offset in pixels. Supported values: 0 — 20 pixels.
Distance
e Specify the Angle at which the shadow is cast from the button. Supported
Angle values: -180° to 180°.

There are also Transparency and Texture settings. You can adjust the transparency of active, passive and

hovered buttons separately. The advanced texture options are very similar to the same settings you can

select for the page Background. For more information about these options, see the description in the

Background section described above.
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Button Options

0K General
E] Tranzparency

@ T exture

B Shadow

page
x
Texture
KTy
e Flips |I"-J|:une v|
Sk Rotate: |I"-J|:une v|
o Scale: - 00 5 %
@ Blend mode: |O'-.:'erla',.f v|
E Transparency: a0 | %

Bel| Color weight: =

wi| Colar sakuration:

@ Conkrask:

)

Smark Invert: Mo

4

To finish the Button design you can change the overall Fill of the Buttons, or change the Text settings. The

Text option allows you to change the color of Buttons and Hovered Buttons, as well as, adjust Font settings.

A Text~|
Colors
[BK] | Button »
@ Hovered Button  *
Font
T Font Family r
At | Size »
£ | Style 3

[ Font Options...
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14. Footer

The Footer tab is used to specify the style of the footer at the bottom of the page.

Footer
l:l(...ll E—=| [CHEMargin  Fill- |2 aiign - A Text~ L Text...
= = IEITexture* | EText Padding ~ | =2 Hyperlink ~ Footnote =
Suggest Footer Length and - -
98 F‘nsg:tinrl" | Gradient - RSS' EL Image -
Ideas | Layout | Footer Styles [

Ribbon Options

The Ribbon bar options for Footer come in two groups: Layout settings and Footer Styles. With the help of

the Footer Styles you can add and/or modify:

e Color

e Gradient

e Texture

e Alignment

e Text Padding

e Text font

e Hyperlinks style
e RSSicon

e Footnote (page footer text, page footer link)
e Image

e HTML text

You can choose an RSS icon from a gallery of RSS icons, or insert a custom icon of your own.

All of these options apply to how the footer and parts of the footer appear. You can also edit the HTML that
defines the footer. To edit the footer HTML, select the Text button:

L} Text...
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Edit HTML

1 kp}{a href="#">Linkl</ax | <a href="#">Linkz</a>x
Rezerved.</ px

You can access the advanced options for the footer by clicking on the Custom Values = icon. The
advanced options include Footer (display) and Texture options. The Footer option has the following
settings: Top margin (- 200 — 200 px), Top Outline, Padding (0 - 50 px), Transparency (0 — 100%), Gradient
Contrast, RSS Align (left/right), and RSS Offset (0 — 100 px). The Texture settings are very similar to the
same options you can set for the page background. For detailed information on Texture settings see the

subsections for Texture Options and Texture Position under the Background section described above.

Footer Options X
|| Foater Footer
T esture —
[ Top Margin: - pix
[J__]J Top Outline: Mo v|
TEI Padding: —= pi
|__| Transparency: = o
Gradient
wm| Gradient conkrask: o %
R55
= aign: Left ,|
Th OfFset: —i— pix

artisteer.com | page

122



Web Design Revolution page

".NET Framework is not installed"
Artisteer requires .NET Framework 2.0 or higher to be installed on your computer.
Solution

Microsoft NET Framework can be obtained and installed from:

PHP fatal error in WordPress

PHP Fatal error: Only variables can be passed by reference in ...\wordpress\wp-includes\query.php on line
2548

Occurs when the posts page is set to a static page different from the homepage:
Solution

Upgrade your PHP version or use the following workaround:

Open the query.php and replace the code line
$this=>queried_object = & get_page(get_option('page_for_posts"));
with the two lines

$tmpPageVariable = get_option(‘page_for_posts");
$this>queried_object = & get_page($tmpPageVariable);
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CMS

A Content Management System (CMS) is a software application designed to create, edit, publish and
manage Website content using a simple browser-based interface. The content may include text, photos,

electronic documents, music, video and other type of computer files.

CMSs usually provide a number of ready-made solutions and standard templates for most common

applications.

The main advantage of a CMS is that it requires almost no technical skills or knowledge to create the

website and manage its content.
Blog

A blog (short for "Web log") is a special type of Web site with a series of entries usually posted to a single

page in reverse-chronological order.

Blogs are often maintained by an individual and represent the personality of the author, provide diary-type
commentary, links to articles on other Web sites, descriptions of different events and social issues, or

include other material such as graphics or video.
WordPress

WordPress is an open source blog publishing application, an advanced blogging tool with a focus on

aesthetics, web standards, and usability. The official WordPress website is
Joomla

Joomla is a free open source content management system written in PHP. It is used for publishing and
managing content on the web and intranets and allows you to build powerful online applications.

The official Joomla website is http://www.joomla.org.
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Drupal

Drupal is a free software package that allows an individual or a community of users to easily publish,
manage and organize a wide variety of content on a website. It is an open-source project written in PHP

and distributed under the GPL. The official Drupal website is
Visual Studio

Visual Studio is an integrated development environment (IDE) from Microsoft. The official website is

CodeCharge Studio

CodeCharge Studio (CCS) is a Rapid Web Application Development Tool from YesSoftware. CCS can be

used to visually create dynamic database-driven Web applications. The official company website is

HTML

HyperText Markup Language (HTML) is the predominant markup language for Web pages which provides a
set of markup symbols or codes to specify the structure of documents for retrieval across the Internet using
Web browser programs. HTML is written in the form of tags, surrounded by angle brackets. The document
can contain links, headings, paragraphs, lists, and text supplemented with interactive forms, embedded

images, and other objects.
CSS

Cascading Style Sheets (CSS) is a style language that defines the presentation of a document written in a
markup language. CSS controls the overall layout, text size, style, formatting and other design properties to

let developers separate content from design.
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RGB

RGB stands for the three primary colors of light - Red, Green, and Blue. The combination of these colors in
different proportions produces any color in the visible spectrum. RGB system is used for representing colors

on computer display.
HSL

HSL stands for Hue, Saturation, and Lightness. It is a method for describing colors as they are perceived by

a human eye. HSL is considered a more intuitive way of dealing with color than RGB.

Hue corresponds to the actual color, saturation corresponds to the intensity, and luminosity corresponds to

lightness of the color.
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